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FDOT CONNECT WORKSPACE OVERVIEW  

This course was developed to introduce OpenRoads Designer CONNECT Edition - OpenRoads Technology tools 

for design and modeling on Florida Department of Transportation (FDOT) projects.  The curriculum was 

developed within the FDOTCONNECT Workspace to provide sample exercises for most of the new Civil Tools 

on a sample project data set.  

INTRODUCTION 

Participants of this course will be introduced to the newest OpenRoads Technology and a Workflow for 

designing two dimensional (2D) Plans, Profiles, Cross Sections and three dimensional (3D) Models for 

Construction Deliverables.  At successful completion they will have learned how to: 

• Create a Terrain Element from the existing surface to be used as a reference for the project. 

• Develop Existing Feature Terrain Surfaces to be shown on cross sections and used in earthwork calculations. 

• Use Civil Geometry Elements in the design file to calculate and define a proposed centerline of construction 

and while using the built in Design Standards Criteria checking. 

• Use Civil Geometry Elements in the design file to define the roadway features of the proposed design.  

• Apply Civil Cells delivered within the FDOTCONNECT Civil Cell DGN library. 

• Use Civil Geometry Elements in the design file to define the vertical profiles of a proposed centerline. 

• Use the Standard Components and Templates within the FDOTCONNECT Template library. 

• Create a 3D Model of the existing and proposed Roadways. 

• Reference 2D Civil Geometry Elements to a Corridor Model by adding the elements for use as design model 

control lines. 

• Apply varying Typical Section conditions along the project; including variable medians, special ditches, 

handrail checks, gravity wall placement, slope conditions, left and right turns, etc. 

• Define the Superelevation Standards along a corridor. 

• View Dynamic Cross Sections for review, updates, and design checks along the project before cross sections 

are created for printing. 

• Create and display 3D Models for better designing and visualization. 

• Use the Milling Overbuild and Overlay Components on a project corridor. 

• Apply Corridor Modeling Techniques used for developing driveways and intersection, etc. 
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EXPECTATIONS – WHAT THIS COURSE PROVIDES 

This course provides a standard workflow for designing a project with Bentley Systems OpenRoads Designer 

CONNECT Edition - OpenRoads Technology within the FDOTCONNECT Workspace. Although most tools are 

used throughout, this course does not provide a description of every Bentley Systems OpenRoads Designer 

CONNECT Edition - OpenRoads Technology Civil Tool.  Integrated help for each of the tools can be found 

by selecting FILE then going to the backstage and selecting Help to bring up Bentley’s ONLINE HELP or from 

the Ribbon pick the HELP icon.   

 

 

FILE > HELP 
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DOCUMENT STYLE  

Style conventions used throughout the course guide are shown in the following table. 

Item Convention Example 

Menu names and 

commands 
Bold N 

(Names separated with > 

symbol) 

• File > Open 

• File > ComSelect > Design 

Dialog box Actions Bold • Click the Apply button. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include box. 

• In the Segment Type list, click Lines. 

Dialog box Field 

Names 
Italic • Key in Hemfield Road in the Alignment 

Name field. 

• Click the Graphic Select button to the right 
of the Horizontal Alignment Include field. 

• In the Segment Type list, click Lines. 

Key-ins Bold • Key in Hemfield Road in the Alignment 
Name field. 

File Names Italic • Open the file  ALGNRD01.dgn in the 
C:\WorkSets\FDOT\22049555201\Roadway. 

File Paths Non italic • Open the file  _Blank.dgn in the 
C:\WorkSets\FDOT\22049555201 

New Terms or 

Emphasis 
Italic • The Template Library contains templates, 

which represent typical sections of the 
proposed roadway. 

 

We would like to introduce the user to a new workflow terminology using the Ribbon.  If you see a direction like 

this:   

OPENROADS MODELING > GEOMETRY > HORIZONTAL > Lines > Line From Element > Simple Line 

From Element  

This means we are in the WorkFlow of OpenRoads Modeling which has a Tab named Geometry and has tools 

that are located in the Horizontal Group. Now that we are in the right workflow, Tab and Group we may need 

to click on a tool that has more than one option. 
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FILE TYPES 

The Bentley Systems GEOPAK OpenRoads Technology road design process now uses a single source file 

type, the DGN file.  All pertinent design data is stored in the design file. This information can be viewed through 

the Project Explorer and reported on in the Civil Report Browser. 

Below is a brief description of the legacy file types used in GEOPAK which can be imported or exported (i/o) 

with OpenRoads Technology. 

File Type Description: 

• Surface.tin  (i/o) - A binary file, also known as a GEOPAK digital terrain model (DTM),that stores features 

made up of random points, break lines, and boundary data along with triangulated surface model. The features 

and the triangles together represent an existing ground surface. 

• Surface.dat (i) - A binary (or ASCII) file containing string and point information that is used for digital terrain 

model construction. 

• Surface.dtm (i/o) – A binary file, also known as a Roadway Designer digital terrain model that stores features 

made up of components, break lines, and boundary data along with triangulated surface model. The features 

and the triangles together represent either existing ground surface or the proposed roadway corridor model. 

• Template Library.itl (i) - Stores templates and template components. Different components can be assembled 

to build templates, which define the typical sections of a roadway. Only one Template Library file may be 

open for editing at a given time. 

LEARNING RESOURCES 

There are several resources available for learning about the various Bentley Systems OpenRoads Designer 

CONNECT edition OpenRoads Technology tools. Among them are: 

• Bentley Communities: 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openr

oads-designer 

http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-

faqs.aspx 

• Bentley Learn:  

Bentley Institute site is for registered user and may require a Select Server site license to participate:  

https://learn.bentley.com 

Bentley Product OpenRoads:  Videos are available on a variety of topics: https://www.Bentley.com  

• YouTube: 

Bentley OpenRoads Videos are available on a variety of topics:http://www.youtube.com/user/BentleyCivil  

• YouTube Search - Google:   

Bentley OpenRoads returns several sites with videos for learning how to apply the technology on project 

specific situations. 

• Production Support Office | CADD (CADD) Website:  http://www.fdot.gov/cadd/ 

Webinar training recordings are available on many of the subjects covered in this manual:   

http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm 

http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection 

https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A 

https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openroads-designer
https://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/33435/openroads-designer
http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
http://communities.bentley.com/products/road___site_design/w/road_and_site_design__wiki/7021.openroads-support-clips-technotes-faqs.aspx
https://learn.bentley.com/
http://www.bentley.com/
http://www.youtube.com/user/BentleyCivil
http://www.fdot.gov/cadd/
http://www.fdot.gov/cadd/main/FDOTCaddTraining.shtm
http://www.fdot.gov/cadd/downloads/webinars/Posted.shtm#loadSection
https://www.youtube.com/channel/UCqbY8kqZuXp1pyYV6lIQw_A
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COURSE SUPPORTING FILES 

The exercises for each chapter are independent of one another and can be used without having to complete the 

exercises in previous modules. The exercise files are organized into separate completed Selected zip files for each 

chapter.  All files used in this course are located also at this link:  

http://www.fdot.gov/cadd/downloads/documentation/FDOTRDAnd3DM/FDOTRDAnd3DM.shtm 

 INTRODUCING A NEW WORKSPACE  

FDOTCONNECT PREDEFINED SETTINGS 

 

DESIGN FILE SETTINGS: 

  

 

http://www.fdot.gov/cadd/downloads/documentation/FDOTRDAnd3DM/FDOTRDAnd3DM.shtm
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FDOTCONNECT WORKSPACE PREFERENCES: 
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FDOTCONNECT FUNCTION KEYS  

FDOTCONNECT Function Key Assignments 

F1 Opens the OpenRoads Designer OnLine Help. Ctrl+F1 Closes all Views except View 1 

F2 Open View 1 (2D Plan) and View 2 (3D Isometric) and fits both views. 

F3 Opens View 3 (2D Plan), closes all View 4, and arranges all Views. 

F4 Open View 1 (2D Plan) , View 2 (3D Isometric), View 1 (2D Plan), View 1 (2D Plan) & 

Fits All views 

F5 Toggles Dim References ON/OFF 

F6 Resets out of any ongoing commands. 

F7 Toggles the Construction view attribute ON/OFF. 

F8 Toggles between MicroStation AccuDraw and Civil AccuDraw. 

F9 Toggles (opens or closes) the Reference dialog. 

F10 Toggles (opens or closes) the Level Display dialog. 

F11 Toggles (opens or closes) the Project Explorer dialog. 

F12 Opens the Create Template dialog. 
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• Function Key F1 – Civil Help 

 

 

• Function Key F2 – Open and Fits Two Views Setup; View 1- 2D Plan, View 2-Isometric 
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• Function Key F3 – Opens View 3; Closes View 4 and Arranges Views 

 

• Function Key F4 – Opens and fits Four View Setup; View 1- 2D Plan, View 2-Isometric, View 3,4 - custom 
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• Function Key F5 – Toggle Dim References 

   

• Function Key F6 – Resets Out of Any Ongoing Commands. 

 

• Function Key F7 – Toggles On/Off Construction View Attributes 
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• Function Key F8 – Toggles Between MicroStation AccuDraw and Civil AccuDraw 

  

• Function Key F9 – Toggles Reference Dialog Open\Close. 

 

• Function Key F10 – Toggles Level Display Dialog Open\Close. 
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• Function Key F11 Toggles Project Explorer Dialog Open/Close. 

  

• Function Key F12 Corridor Modeling, Opens Create Template Dialog. 
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FDOTCONNECT USER CONFIGURATION VARIABLES 

  

FDOTCONNECT DESIGN AND 3D MODELING OVERVIEW 
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GENERAL WORKFLOW 

1. Existing Terrain and Existing Features 

2. Design Centerlines Alignments  

3. Prepare 2D Plan Layout  

4. Design Profiles 

5. Define Project Templates 

6. Create 3D Design Model and add 2D References 

7. Create Cross Section View 

8. Define Superelevation and Assign to the Corridor Model 

9. Detail Modeling for Intersections, Median Traffic Separator Nose, Side Roads, 

Driveways, Curbs Ramps, etc. 

10. Prepare Construction Deliverables. 

RECOMMENDED MICROSTATION SETTINGS  

Various tools and settings will be used throughout the workshop. Therefore for quick accessibility, several of the 

dialogs are better docked on the sides the MicroStation view.  

GETTING STARTED 

LAUNCHING FDOTCONNECT FOR OPENROADS DESIGNER  

FDOT Connect can be launched from the FDOT – Roadway and FDOT – ROW icons located in the 

FDOTConnect folder on your desktop.  The first time it is launched, it is important to select the FDOT 

workspace from the workspace dropdown.  

1. Find the FDOT Connect launch icons on your desktop or locate the “FDOTConnect” folder on 
your desktop.  
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2. Launch FDOTConnect for OpenRoads Designer by double-clicking one of the FDOT icons. 

Note that your FDOTConnect launch icons will vary depending on which Bentley Connect 

Edition platforms you have installed. FDOTConnect will create an icon for OpenRoads 

Designer, an icon for MicroStation Connect Edition (MSCE), and an icon for OpenBridge 

Modeler (OBM) depending on which of these applications is present on your machine during 

installation of the Workstation or Client. (This release of FDOT Connect is the “Alpha test” 

version for OpenBridge Modeler). 

  

3. In the Workspace/Workset select screen of OpenRoads Designer, select the Workspace 

selection drop-down menu by clicking on “No Workspace.”  

  

4. Select “FDOT” from the drop-down menu to select the FDOTConnect workspace.  
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5. From here, you can now create a new WorkSet,,this is done by selecting the drop-down menu, 

being sure to select the FDOT’s “0_WORKSET_TEMPLATE” as the workset template.   

   

6. Click “OK” after filling in the Create Workset dialog.  

 

7. After creating a new project using the FDOT Workset Template, you can create new files using 

the FDOT Create File tool.  This tool is launched from within the FDOTConnect workspace, 

so you must first open a file.  The FDOT Workset template includes a blank starting file from 

which to launch the Create File tool.  

8. From the OpenRoads Designer file open dialog, select “Browse” to browse the contents of 

your new workset. 
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9. Locate “_Blankfile.dgn” at the root of your workset folder structure. Select this file and then 

select “OPEN” to open it. 

 

10. When the FDOTConnect Workspace opens, you can locate the FDOT ribbon by selecting the 

“OpenRoads Modeling” workflow from the menu at the top left of the screen. The FDOT tab 

is located at the far right of this ribbon.  Select “Create File” to launch the Create File tool for 

creating FDOT project files.   
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MENU DOCKING 

  

1. Verify that the Civil Message Center tool is already docked on the bottom; if not, select it from 

the General Geometry Task group, dock and unpin.  

   

2. Verify that the Project Explorer is docked on the left side; if not, from the Ribbon select the 

Home tab then in the group named primary click on the explorer icon…Or use the F11 function 

key to toggle ON/OFF the dialog. 

   



FDOT CONNECT WORKSPACE OVERVIEW ______________________________________ Recommended MicroStation Settings 

FDOTCONNECT for ORD Workflows ©2020 FDOT  19 

3. Verify that the Level Display is docked on the right side; if not, from the FDOT-Function Keys 

press F10, dock and unpin.  

 

4. Verify that the Element Information is docked on the right side; if not, this can be brought up 

by selecting Ctrl+I , dock and unpin. 

  

 Many of the dialog settings are stored in user preferences defined in xml data files located in the users 
data folders i.e. C:\Users\rd964vd\AppData\Local\Bentley\OpenRoadsDesigner\10.0.0\prefs. 
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1 EXISTING FEATURES MODELING 
WORKFLOW 

EXERCISE OVERVIEW – EXISTING FEATURES ORD  

1.1 Create Polygons (Closed Complex Shapes/Line Strings  

1.2 Create Clipped Terrain Models from Clipping Elements 

1.3 Creating a 3D Terrain Model Boundary by Active Profile 

1.4 CONCLUSION 

Exercise 1.1 Create Polygons (Closed Complex Shapes/Line Strings 

 Open FDOTConnect, set the Workspace to “FDOT” and select the Workset – “3D Modeling Workshop”. 

 Browse to the “_BlankFile.dgn” and open.  

 On the FDOT Ribbon Tab in the Actions Group, select “Create File.” 

• Discipline = “ROADWAY” 

• File Group = “Roadway Files” 

• File Type = “MODLRD” 

• Modifier (Optional) = “_EX_” 

• County = “Wakulla” (Coordinate System = FL83-NF) 

 Click on the “Create – Open File” button.  Close the Create File Dialogue box. 
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 On the FDOT Ribbon Tab select in the Roadway Group select “Create Existing Features”. 

 

 When prompted, attach the project survey SURVRD01.dgn.  Note that this will attach the SURVRD01.dgn 

as a reference file (visualization is set to off) and copy into the active 2D MODLRD file the existing pavement 

and curbing features only. 

 Use the drop down in the FDOT Features dialogue to select “Pavement”.  This tool will visualize only the 

applicable features for the selected hard surface categories.  In this case turning on only the “PavtAsphalt_ep” 

level. 
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 Use the “Place Feature Line” tool to draw asphalt pavement lines at the points indicated below.  These lines 

will be the limits of the polygons (closed complex shapes/line strings). 

  

  

 Use the “Create Feature Shape By Flood” tool to create the 2D polygon to the limits defined by the added 

pavement lines.  Left-click inside the Roadway and left-click again to accept the polygon. 
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 Again, use the “Create Feature Shape By Flood” tool to Left-click in each of the median areas to define those 

polygons.  All of these newly created polygons are known as “Clipping Elements”. 
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 You are now done creating “Clipping Elements”.  It is important to turn off/shut down the Create Existing 

Features tool.   

WARNING:  Leaving this tool on and opening a file could damage the new file by copying in 2D pavement 

lines. 
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Exercise 1.2 Create Clipped Terrain Models from Clipping Elements 

Note When the “Create Existing Features” tool is used and the Survey (SURVRD01.dgn) is attached, the survey 
is automatically displayed with only the DTM_ex level on.  Exercise numbers 12 and 13 can be skipped 
unless needed to redisplay the Survey with the Terrain Model only. 

 Open the Level Display dialogue and select the SURVRD01.dgn reference file and right click to turn on the 

reference file “Display”.  

 Use the Standards file level filters to select the GDTMRD levels.  This will display the SURVRD01.dgn 

Terrain Model only. 

 

 In the Terrain Ribbon Tab in the Create Group use the “Additional Methods” drop down to find the 

“Create Clipped Terrain Model” tool.  Use this tool to create an “External” Terrain Model of the shape 

that was created above. 

 

Note Once the Clipped Terrain Model tool has been used it will be the default tool until another is used. 
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 When prompted to “Locate Reference Terrain Model Element”, select the boundary of the Existing 

Ground from the referenced SURVRD01.dgn.  When prompted to “Locate Clipping Element”, select the 

SR61 polygon (Clipping Element). 

   

 Make sure in the contextual dialogue box, that the Clipping Method is set to “External”.  Set the Feature 

Definition to “DTMExistingFeature”.  Give the clipped terrain model a Name, in this case “SR61-Temp”.  

Right-click (Reset) in the view when you are done.  Give your clipped terrain a horizontal and vertical offset 

or continue to left-click to default these offsets to zero (0). 
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 Your final left-click in the view should clip out the Roadway into a Terrain Model named “SR61-Temp”.  

This process also creates a 3D Design File Model containing the clipped Terrain Model and references it to 

the 2D Model. 

Note Clipping creates a Parent – Child relationship between the referenced Terrain Model (Existing Ground) and 
the newly created clipped Terrain Model (SR61-Temp).  The two terrain models are dynamically linked.  If 
the parent Terrain Model changes then the child Terrain model will change. 
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Exercise 1.3 Creating a 3D Terrain Model Boundary by Active Profile 

 Set the parent Terrain Model (Existing Ground) to the active Terrain Model by selecting hovering over the 

boundary of the Terrain Model to open the contextual menu.  Select “Set as Active Terrain Model”. 

 

 Select the 2D Clipping Element and hover to get the contextual menu.  Click on “Open Profile Model”. 
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 Open a new view to display the profile model and left click in the new view to visualize the profile. 

 

 In the new view, select the profile and hover to show the contextual menu.  Click on the “Set As Active 

Profile” tool.  Setting the Active Profile creates a 3D boundary out of the 2D Clipping Element. 
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 Close the profile view.  You are now ready to add the newly created 3D boundary to the clipped Terrain 

Model (SR61-Temp) as a Boundary Feature. 

 In the Terrain Model Ribbon tab in the Edit group, select the Feature Management drop down and click 

on the “Add Features” tool. 

 

 Locate the Clipped Terrain Model (SR61-Temp) to Add Elements.  Locate the newly created 3D boundary 

as the “Element to Add”.  Set the Feature Type to “Boundary” and left click in the view. 
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 Adding the 3D boundary to the Terrain Model has constrained the triangles to inside the Clipping Element. 

NOTE:  The Edge Method for this Terrain Model is now defined as “From Boundary”. 

 

 Select the SR61-Temp Terrain Model and in the Properties Dialogue box, turn off triangles. 
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 Use the “Create Clipped Terrain Model” tool again to clip out a new Terrain Model using the SR61-Temp 

as the Reference Terrain Model Element and the two medians as Clipping Elements.  You may select 

both medians as clipping elements in the same clip.  Set the Feature Definition to “DtmExistingFeature” 

and name the Terrain Model “SR61”. 

Note When multiple clipping elements are selected the Clipping Method automatically defaults to “Internal” and 
cannot be changed. 

   

   

  



Chapter 1  EXISTING FEATURES MODELING WORKFLOW _________________________ Recommended MicroStation Settings 

1-14 ©2020 FDOT  FDOTCONNECT for ORD Workflows 

Exercise 1.4 CONCLUSION: 

Clipping SR61 a second time internally, excludes the Medians from the SR61 Terrain model.  The Terrain Model 

SR61 is a child of SR61-Temp which is a child of the Existing Ground Terrain Model.  All are dynamically 

linked.  If the Existing Ground Terrain Model changes then the SR61 Terrain Model will change too.  Also note 

that the Edge Method for SR61 inherented the “From Boundary” setting from SR61-Temp.  The SR61 

Existing Feature Model is ready for a surface template to add depth to the model. 
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2 2D DESIGN GEOMETRICS 
WORKFLOW 

CENTERLINE ALIGNMENTS AND RIGHT OF WAY 

This chapter will introduce three (4) important OpenRoads Technologies for creating geometry/line work 

while designing in FDOTCONNECT.  They are: 

• Feature Definitions 

• Civil Geometry Design Intent  

• Design Standards 

• Annotation Groups 

We would like to introduce the user to a new workflow terminology using the Ribbon.  If you see a direction like 

this:  OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line From Element>Simple Line From Element, it means 

we are in the WorkFlow of OpenRoads Modeling which has a Tab named Geometry, and has tools that are 

located in the Horizontal Group. Now that we are in the right workflow, Tab and Group we may need to click 

on a tool that has more than one option.  

FEATURE DEFINITIONS 

As defined in the Bentley Civil Tools help files: 

“Feature Definitions are used to control symbology, annotation, and various other properties 

that are applied to the geometric elements. .  The feature definitions are used to: 

• Define what the geometric elements actually are. What is being modeled such as curb, 

centerline, edge of pavement, etcetera. 

• Control symbology in various views, including capability to define differing symbology 

in plan, profile, and 3D spaces 

• Define terrain modeling attributes (spot, break line, void, etcetera) 

• Define surface display characteristics 

An extensive FDOT_Standards_Features.dgnlib has been developed for the FDOTCONNECT Workspace to be 

used for all FDOT projects. All elements placed in the design file should have a defined Feature definition. The 

Civil Geometry tools can be set with an Active FDOT Civil Features for element creation and assignment. They 

can be viewed in the Project Explorer and in the Feature Toggle Bar. 
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DESIGN INTENT 

As defined in the Bentley Civil Tools help file: 

“Design intent builds associations and relationships between civil elements. Object information 

(how, where, and by what method it was created) is stored with the object to insure the original 

intent is retained and honored in the design. If an element is modified, any related elements will 

recreate themselves based on these stored relationships. 

Civil Geometry or rule-base elements are created intelligently as the tools are used and elements are constructed. 

The FDOTCONNECT Workspace and design development workflow is highly dependent on using Civil 

Geometry for the 2D plan layout rather than traditional MicroStation place elements tools. 

DESIGN STANDARDS  

Also known as Design Geometrics and Criteria and as defined in the Bentley Civil Tools help files: 

“Design standards can be used to maintain required curvature and other alignment checks when 

performing geometric layouts. They work at two levels: 

• Provide values for the element creation tools (for example, minimum radius and 

transition lengths) 

• Check the suitability of complex elements (for example, check for kinks in the 

alignment) 

Design standards are very alignment oriented. You may find limited value for using design 

standards for non-alignment computations. 

When a design standard is violated, feedback is provided in two ways: 

• An icon in the graphics on the element that has the problem. Hover over the icon to 

reveal a tool tip report of the error. 

• In the Civil Message Center 

An extensive FDOT_DesignGeometricsCriteria.dgnlib has been developed for the FDOTCONNECT Workspace 

to be used for all FDOT projects. Alignments created in the design file either with Civil Geometry Tools or 

Imported should have a set Design Geometrics Criteria. FDOT Design Geometrics Criteria can be viewed in the 

Project Explorer and in the Design Standard Toggle Bar.  

ANNOTATIONS 
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EXERCISE OVERVIEW – CENTERLINE ALIGNMENTS 

In this chapter exercise, the existing roadway Baselines for SR61 and US98 will be imported from a provided 

(LandXML) file. A new Centerline of Construction for the SR61 roadway is required to improve the intersection 

with US98. The new intersection will be located across from the School entrance on US98. It will be a 90 degree 

angled intersection from US98.  The centerline will require a new horizontal curve following the FDM design 

guidelines as follows. In order to provide minimal property impacts to a local business on SR61 the alignment 

will be offset from existing baseline to the west 30 feet and will re-join SR61 at a small skew that does not require 

a horizontal curve. 

Design Geometrics and Criteria FDOT Design Manual (FDM), Part 2 Chapter 210  

Design Speed 45 MPH 

Facility Low Speed Desired Length  

Maximum Tangent Deflection w/out curve 1 Degree   Section 210.8.1 

Minimum Horizontal Radius 694 feet  Table 210.9.2 

Minimum Length of Curve 675 feet  Table 210.8.1 

Context Class C3 Max Grade Table 210.10.1 

➢ Low Speed Minimum Length – This will give a minimum Radius at Max Super (emax = .05) 

➢ Low Speed Desired Length – This will give a desired length of curve at Normal Crown  

Note Refer to the FDM for Tables 

 

2.1 Import Baseline  

2.2 Copy Baseline of Survey into ALGNRD 

2.3 Design New SR61 Centerline  

2.4 Import Side Roads  

2.5 Baseline Side Road Design from BL98 

2.6      Using Annotation Groups to Label Your Alignment Features 

2.7 Geometry Builder 
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Exercise 2.1 Import Baseline  

Import Baseline In this exercise, the user will create a new design file and import chains from the LandXML  file 

provided from the survey.  

 From the desktop FDOTCONNECT folder, double-click on the FDOTConnect for OpenRoads Designer 

icon.  

  

 Navigate to FDOT Ribbon Tab of the OpenRoads Modeling WorkFlow looking for the Actions Group click 

on the create file. Create a ALGNRD01.dgn file with the dialog as shown below 

OPENROADS MODELING>FDOT>ACTIONS>Create File 

  

a. From the Create File Dialog box pick the Base Filename of ALGNRD 

b. Select your County, by selecting this the correct coordinate system will be selected. 

c. Click Create - Open File to create the file, ALGNRD01.dgn.  

d. You are now in the ALGNRD01.dgn Click Close.   

e. Navigate to the models Dialog, you will notice that during the creation of the ALGNRD a new 

model of SUPERELEVATION was created. 
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  If the SURVRD file exists use the Attach Survey Reference tool which is located on the FDOT Tab, with 

in the Roadway Group. These Tabs and Groups can be found within the OpenRoads Modeling WorkFlow;  

otherwise, skip to step 7.  

OPENROADS MODELING>FDOT>ROADWAY 

  

 Select the SURVRD01.dgn file. 

 

 From the Function key F9 (toggles on the Reference Dialog) to view the attached files: 

 

 From the Function key F9 (toggles on the Reference Dialog) and attach the following files: 

• C://e/projects/survey/TOPORD01.dgn (disregard if SURVRD exists) 

• C://e/projects/rwmap/RWDTRD01.dgn  - Set the Logical Name to RWDTRD 

• C://e/projects/roadway/AERIALS.dgn  - Set the Logical Name to AERIALS 

 Fit View and Save Settings, select Ctrl F. 
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 From the Home tab, set Active Level to BaselineSurvey before you import. 

Note Active Level needs to be set to BaselineSurvey or CLConst_dp before you import. 

 Use the OpenRoads Modeling workflow to locate the Geometry Tab, then in the General Tools Group is 

where you will find import tools, Import/Export tool – import Geometry and select the Landxml file in the 

Roadway folder to import alignments. We are looking for the file name BL98.xml. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Import 

Geometry 

 

a. Navigate to the Alignment > Alignment>BL98 folder.  

b. Click in the box to select BL98. 

   

c. Click Import.  

d. Repeat this process to import the existing baseline for SR61. The file name of this LandXML is 

EX61.xml. 
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 Zoom to the intersection of EX-SR61 and US98, hover over the baseline to verify the alignment imported in 

the previous step. You will notice that the Baseline for US98 already has a Feature Definition assigned to it. 

 

 Use Geometry Tab, and the General Tools Group, and then click on the Standards icon bring up the dropdown 

list that for the Set Feature Definition Tool.  OPENROADS MODELING>GEOMETRY>GENERAL 

TOOLS>Standards>Set Feature Definition 

 

a. Set the Feature Type to Alignments. 

b. Set the Feature Definition to Baseline. 

 

c. Select the EX-SR61, then click Reset to set the Baseline feature on the line.  

 Select the Element Selection to exit the command, you can also do this by the function Key F6. 
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Exercise 2.2 Copy Baseline of Survey into ALGNRD  

This exercise will copy the Baseline of Survey into Alignment file and be used for the controlling alignment low. 

 From the desktop FDOTCONNECT folder, double-click on the FDOTConnect for OpenRoads Designer 

icon.  

  

 Navigate to FDOT Ribbon Tab of the OpenRoads Modeling WorkFlow looking for the Actions Group click 

on the create file. Create a ALGNRDxx.dgn file with the dialog as shown below 

OPENROADS MODELING>FDOT>ACTIONS>Create File 

  

a. From the Create File Dialog box pick the Base Filename of ALGNRD 

b. Select your County, by selecting this the correct coordinate system will be selected. 

c. Click Create - Open File to create the file, ALGNRD01.dgn.  

d. You are now in the ALGNRD01.dgn Click Close.   

e. Navigate to the models Dialog, you will notice that during the creation of the ALGNRD a new 

model of SUPERELEVATION was created. 
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 Attach the SURVRD as a Reference file through the Reference Dialog (Press the function key F9 to bring 

the dialog up). Select the attach reference and navigate to the survey folder of the project and select the 

SURVRD. 

 

 Select the SURVRD01.dgn file. 

 

 In the Attach Reference dialog give the SURVRD a Logical name of TOPO all other setting should be set as 

dialog below. 

.  
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 Once the SURVRD is attach click the fit view button to view the survey. 

 Next press the function F10 to bring up the level Display dialog. Selecting the SURVRD turn all levels off 

by right clicking but leave on the BaselineSurvey. 

 In the OpenRoads Modeling workflow select the Geometry Tab, then locating the Horizontal Group select 

the split button  arrow under Modify to select the COPY Element Tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Copy Element 

 

8. Once the Copy Element Tool is select follow the prompts of the cursor to select the elements that will be 

copied into the file. Once all elements are selected right click (reset) then data point Left click to accept.  

9. To verify that the elements were copied into the file select them. The handles will show. 

Exercise 2.3 Design New SR61 Centerline  

This exercise will use several Construction lines to create the final Centerline as shown below. 
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➢ ConstLines1 

 Locate the Driveway into the school off US98 between the baseball field and the parking lot. 

 

 Now that the new intersection is located, turn the display OFF for the Aerial Reference file. 

 Use the Geometry Tab and the Horizontal Group, to select the Line Between Points tool. OPENROADS 

MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 

 

a. Use Feature Definition Const Lines Blue Dash and a Name of  ConstLines1. You will have to add 

the 1 to the name.  

b. Start a line perpendicular to BL98 and ending at in the middle of the Driveway. Be careful not to 

snap to anything on the second point. 
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➢ ConstrLines2 

 Use the Geometry Tab and the Horizontal Group, to select the Simple Line From Element tool.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line From Element> 

Simple Line From Element. 

 

 Use Feature Definition Const Lines Blue Dash and Name ConstLines2 

 First select ConstLines1, then use the AccuSnap to locate the beginning of the line at BL98. 

 

 Enter a Distance of -2000 feet. Data point in the View to accept the Distance. 

 Data point to accept Trim None. 
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➢ ConstrLines3 

 Use the Geometry Tab and Horizontal Group, to select the Single Offset Entire Element tool.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Entire Element 

 

 Use Feature Definition Const Lines Blue Dash and Name ConstLines3.  

 Data point in the View to create a line -30 feet Offset to EX-61.  

 Uncheck the mirror option to No, and click in the View.  

 

 Once the new line is created, turn the Display OFF for the SURVRD with Logical Name TOPO in the  

Reference dialog.  
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➢ ConstrLines4 

Next step, create a line from the Offset line to intersect the EX-SR61 line at a 1 degree deflection angle. 

 Find the Bearing Angle of EX-61, select the element and click the Context Menu Description. Copy the 

Bearing value into the buffer space selecting Ctrl C <OR> right-click Copy.         Note: You may have to 

right click on the element to make the bearing value active in order to copy from it.  

 

 Use the Geometry Tab and Horizontal Group, to select the Line Between Points tool. OPENROADS 

MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 

 

 Use Feature Definition Const Lines Blue Dash and Name ConstLines4. 

 Start a line at the intersection of ConstLine2 and ConstLine3 (this can be done by selecting the intersection 

snap) then enter a value of 2000 feet for the Length and use the Bearing in the buffer as the Line Direction 

minus 1 degree. 
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 Use MicroStation Trim to Element and  to Trim ConstLines4 line to intersect EX-61. This step will create 

an interval element with a new Name of ConstLines5. 

 

➢ Verify the Construction Lines Maintain Design Intent 

 Change the Active Level to Scratch1_dp. Use MicroStation Drawing to Place Circle with MicroStation with 

a center at the end of ConstrLines5 

  

 Open View 4 and use Copy View from View 1. Zoom into the School Entrance in View 4 

 

 Move the location of the ConstLines1 and check the end of ConstLines5 to see if the location has been 

corrected.  

 1: Select the first line and Use the manipulator tool  handle in the middle to move parallel location. 

 

 2: Select ConstLines5, Use MicroStation Undo/ Redo to see the end change location. 
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 Select Ctrl Z to undo change. 

 (Extra Exercise) Change the Offset Distance of ConstrLines3 from -30 to -40 to verify that the end of 

ConstrLines4 will change.  

 Select Ctrl Z to undo change. 

➢ Construct a Horizontal Curve between ConstLines2 and ConstLines5 to Meet Geometric 

Standards.  

 Use the Design Standards Toolbar that is already docked at the top of the screen.  

 

 Set Active the Design Facility Standard to: Low Speed Desired Length, 45 MPH. 

 

 Activate the Toggle Active Design Standard icon.   
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 Use the Geometry Tab and the Horizontal Group to select the Simple Arc tool. This tool can be found using 

the Arcs button then selecting Arcs between Elements Simple Arc OPENROADS 

MODELING>GEOMETRY>Arcs>Arcs Between Elements>Simple Arc  

   

 Use Feature Definition Const Lines Blue Dash and Name ConstLines6. 

 Create a Radius between ConstLine2 and ConstLine5 you will notice that setting the Design Standard has 

set a default value of 2083.00’ for the Radius, be sure to change this to 881.00. Set Trim/Extend to Both. 
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➢ Make a Longer Driveway into the School. 

 Select ConstLine1 using the element selection tool. 

 Select the manipulator for length, click it and change the length from 85 to 105 

 

Note After the line is constructed a Warning icon may appear on the line because the Active Design Standard 
icon is being toggled ON and the tangent length may be less than the minimum 100 feet.  

 

➢ Create a Centerline of All the ConstrLines.  

 Use the  Geometry Tab and Horizontal Group, Complex by Element tool. 

 OPENRAODS MODELING>GEOMETRY>HORIZONTAL>Complex Geometry>Complex 

By Element 
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 Create the new Alignment by connecting the elements. Use Feature Definition Centerline and Name 

SR61_CL, with no spaces. Use the Manual Method. 

 

 Be careful to select at the school side first and near the start of the line.  

 

 Continue until New Centerline is constructed as shown below.  
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➢ Set a Begin Station Value at the Intersection of BL98 

 Use the Geometry Tab and Horizontal Group, Start Station tool under the Modify icon. OPENROADS 

MODELING>GEOMETRY>HORIZONTAL>Modify>Start Station 

 

 Set a Begin Station value of 700+00 at the intersection of SR61 and BL98. 

 

 Select the new SR61 Centerline(CL). 

 Use AccuSnap to locate the Intersection with BL98 and data point to accept. 

 Enter 70000 and select Enter <OR> data point to accept.  
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➢ Describe the New Centerline Geometry 

 Use the Geometry Tab and General Tools Group, Horizontal Geometry Report tool under the Reports icon.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Reports>Horizontal Geometry 

Report 

 

 Select the SR61_CL Centerline. Use the settings below at the prompt to generate the report shown. 
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 If the Stationing format is not displayed correctly, In the Bentley Civil Report Browser, select Tools Format 
Options 

 

 

➢ Save the SR61 Centerline to a Landxml for a Back up. 

 Use the Geometry Tab and the General Tools Group, to select the Export to Native tool and save the 

SR61_CL Centerline to a Landxml  file.  

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Export 

Geometry 

 This will bring the Export Dialog up which gives you the option to export as a LANDXML 
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 Select the Alignment you wish to export, select Version 1.2 for export, when prompted save as SR61_CL.xml 

 

Exercise 2.4 Import Side Roads  

 From the Home tab, set Active Level to CLConst_dp before you import. 

 Use the Geometry Tab under the General Tools Group, to select the Import Geometry tool. OPENROADS 

MODELING>GEOMETRY>HORIZONTAL>GENERAL TOOLS>Import/Export>Import Geometry 

 

 Select the following LandXML(FRIENDSHIP.xml)  file: Friendship, Friendship2.  click the Import button. 

  

 Notice from the LandXML a Feature Definition for CenterLine is defined for each alignment.  
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Exercise 2.5 Baseline Side Road Design from US98 

In this exercise Civil AccuDraw is used to help construct a side road centerline on BL98. 

 OpenRoads AccuDraw and Civil AccuDraw should never be toggled ON at the same time because both 

use some of the same Shortcut Key-ins. Toggle OFF the OpenRoads AccuDraw. 

 

 Use Geometry Tab and the General Tools Group, to select the Civil Toggles icon to call Civil AccuDraw 

tool to activate the Civil AccuDraw toolbar. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Civil Toggles>Civil 

Accudraw 

 

 Click on the Mode Station-Offset to toggle ON. 

 

 Use the Geometry Tab and Horizontal Group, to select the Line Between Points tool to create a Centerline 

perpendicular to the BL98 at Station 39+00 for a Length of 80 feet used as a side road centerline. Here are 

the steps to use Civil AccuDraw with the Station Offset option: 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 
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 On the cursor prompt, tab to the offset field and use the Shortcut Key-in o and select 
the reference line BL98. The cursor will now track the station and offset.  

 

 

a. For the first data point, set the Snap Locator button to Perpendicular, and select on the BL98. 
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b. For the second point tab to the Station field in the AccuDraw Cursor Prompt dialog, enter Station 

value 39+00, select Enter to lock in on the station. 

 

c. Tab to the Offset field in the AccuDraw Cursor Prompt dialog, Enter Offset value 80, select Enter 

to lock.  

 

d. Data point in View to place the point. Repeat these steps for the Centerline at Station 36+40.0 
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Exercise 2.6 Using Annotation Groups to Label Your Alignment Features  

 In the ALGNRD file that has been created in the previous exercises. From the OpenRoads Modeling 

WORKFLOW navigate to the DRAWING PRODUCTION TAB and the Annotations Group. There are two 

icon buttons for Annotating. 

 OPENROADS MODELING>DRAWING PRODUCTION>ANNOTATIONS 

 

a. Element Annotation – This will annotate the element and remove the element Annotation Group. 

 

b. Model Annotation – This will annotate all the elements in the model and remove the element 

Annotation Group. 

 

 From the Drawing Production Tab and the Annotations Group, Select the Annotate Element button then 

following the prompts by the cursor. Select SR61 Centerline (optional you may select multiple alignments if 

you like) The n reset the tool by right click.  

OPENROADS MODELING>DRAWING PRODUCTION>ANNOTATIONS>Annotate 

Element 
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 You have now just Annotated your Alignments.  

  

a. If you Navigate to the FDOT Tab on the Ribbon, in the Actions Group will be the Filters Icon Button 

with a Drop Down list. 

 OPENROADS MODELING>FDOT>ACTIONS>Filters 

  

b. From this list you will now be able to control what levels will be displayed for the Annotation Group.  
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c. When you first Annotate the alignments in the level display all levels will be turned on. When using 

the Level Filters for annotation group be sure to change the Drawing Scale to match the applicable 

scale. 

 

 

 Example: For drawing scales from 1”=10’ to 1”=60’ use the Level Filter for Display Only 100 Foot Major 

Annotations   
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Exercise 2.7 Geometry Builder 

This exercise will introduce a new tool that will replace the old COGO tools. Geometry Builder is the new tool 

to quickly layout an alignment. It is found in the OpenRoads Modeling workflow within the Geometry Tab and 

the Horizontal Group. Pick on the split button of Complex By Element to view this tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Geometry Builder 

 From the desktop FDOTCONNECT folder, double-click on the FDOTConnect for OpenRoads Designer 

icon.  

  

 Navigate to FDOT Ribbon Tab of the OpenRoads Modeling WorkFlow looking for the Actions Group click 

on the create file. Create a ALGNRD01.dgn file with the dialog as shown below 

OPENROADS MODELING>FDOT>ACTIONS>Create File 

  

a. From the Create File Dialog box pick the Base Filename of ALGNRD 

b. Select your County, by selecting this the correct coordinate system will be selected. 

c. Click Create - Open File to create the file, ALGNRD01.dgn.  

d. You are now in the ALGNRD01.dgn Click Close.   

e. Navigate to the models Dialog, you will notice that during the creation of the ALGNRD a new 

model of SUPERELEVATION was created. 
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  If the SURVRD file exists use the Attach Survey Reference tool which is located on the FDOT Tab, with 

in the Roadway Group. These Tabs and Groups can be found within the OpenRaods Modeling WorkFlow.  

Otherwise, skip to step 7.  

OPENROADS MODELING>FDOT>ROADWAY 

  

 Select the SURVRD01.dgn file. 

 

 From the Function key F9 (toggles on the Reference Dialog) to view the attached files: 

 

 From the Function key F9 (toggles on the Reference Dialog) and attach the following files: 

• ALGNRD01_GeometryBuilder_01.dgn that is located in the Roadway Folder 

 Fit View and Save Settings, select Ctrl F. 

 From the Home tab, set Active Level to BaselineSurvey before you import. 
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 Use the OpenRoads Modeling workflow to locate the Geometry Tab, then in the General Tools Group is 

where you will find import tools, Import/Export tool – import Geometry and select the Landxml file in the 

Roadway folder to import alignments. We are looking for the file name BL98.xml. (Note: The level needs to 

be set to either Baseline Survey or CLConst_dp before the import from a landxml file)  

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Import 

Geometry 

 

 

a. Navigate to the Alignment > Alignment>BL98 folder.  

b. Click in the box to select BL98. 

   

c. Click Import.  

d. Repeat this process to import the existing baseline for SR61. The file name of this LandXML is 

EX61.xml. 
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 Zoom to the intersection of EX-SR61 and US98, hover over the baseline to verify the alignment imported in 

the previous step. You will notice that the Baseline for US98 already has a Feature Definition assigned to it. 

 

 Use Geometry Tab, and the General Tools Group, and then click on the Standards icon bring up the dropdown 

list that for the Set Feature Definition Tool.  OPENROADS MODELING>GEOMETRY>GENERAL 

TOOLS>Standards>Set Feature Definition 

 

a. Set the Feature Type to Alignments. 

b. Set the Feature Definition to Baseline. 

 

c. Select the EX-SR61, then click Reset to set the Baseline feature on the line.  

 Select the Element Selection to exit the command, you can also do this by the function Key F6. 
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 Click on the Geometry Builder button will bring the dialog up.  

 

 From here click on the add new geometry icon  to start the tool. From here rename to the current project 

centerline name.  

 The first step is to locate a begin point, click on begin point     to select a point from the 

screen 

 

 Once the begin point is set. Select the drop down from the Type Column to pick Line. Then start filling out 

the Bearing and Distance columns with the information from the Table provided. (Bearing N59° 59’ 28” W 

Distance 105.00’) 

 Select Line from the Type column fill out the Bearing and Distance from the Table. (Bearing N59° 59’ 28” 

W, Distance 611.90’) 

 Next Select Arc from the TYPE column fill out Radius, Length, and check the box for Clock, bearing from 

the Table. (Radius 819.00, Length 756.43’ Bearing N34° 13’ 53” W) 

 Select Line from the Type column fill out the Bearing and Distance from the Table. (Bearing N08° 28’ 19” 

W, Distance 265.02’) 
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 Next Select Arc from the TYPE column fill out Radius, Length, and check the box for Clock, bearing from 

the Table. (Radius 7639.00, Length 462.23’ Bearing N10° 12’ 19” W) 

 Select Line from the Type column fill out the Bearing and Distance from the Table. (Bearing N11° 56’ 20” 

W, Distance 524.42’) 

 Now that the New Alignment is designed click on the Create civil ruled elements icon  

  

 Next select the place icon to place the new alignment. 

 

Element: Linear Station Northing Easting

START ( ) 698+95.000 402592.610 2006925.814

Tangential Direction: N59°59'28"W

Tangential Length: 105.00

Tangential Direction: N59°59'28"W

Tangential Length: 611.90

Radius: 819.00

Length: 736.43

Chord Direction: N34°13'53"W

Tangential Direction: N08°28'19"W

Tangential Length: 265.02

Radius: 7639.00

3.467° Right

0.75°

Length: 462.23

Chord Direction: N10°12'19"W

Tangential Direction: N11°56'20"W

Tangential Length: 524.42

Element: Linear

Element: Linear

Element: Circular

Delta:

Degree of Curvature (Arc):

Element: Linear

Element: Circular
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2D PLANIMETRICS: CIVIL GEOMETRY, CIVIL CELLS 

This chapter will continue to use the OpenRoads Technology for Horizontal Geometry. Rather than use 

traditional MicroStation element creation tools, these exercises will provide participants with practice using the 

Civil Tools.  Using Civil rule-based Feature Definitions assures design intent is incorporated into the two-

dimensional (2D) plan layout. This will, in turn, prove valuable when design changes or “what if scenarios are 

needed or tested.   

This chapter also introduces two (2) important new OpenRoads Technologies for creating geometry / line 

work while designing in FDOTCONNECT.  They are: 

• Civil AccuDraw  

• Civil Cells 

CIVIL ACCUDRAW 

As defined in the Bentley Civil Tools help files: 

“Use Civil AccuDraw to allow precise input of points, whether the points are physical points or 

end points of linear geometry. The Civil AccuDraw values can be persisted as rules on the points 

by locking both values in the Civil AccuDraw input. Several methods can be used, among them 

are: 

• Distance and Direction, to set the order of ordinate entry to distance then direction, 

with both sharing a common point of origin. 

• Dist-Dir, to set the order of entry to distance for the first ordinate then direction for the 

second ordinate, without a common point of origin. 

• Dist-Dist, to set the order of entry to distance for the first ordinate then distance for the 

second ordinate, without a common point of origin. 

• XY, to set the order of ordinate entry to X-axis then Y-axis, with the two sharing a 

common point of origin. 

• DX DY, to set the order of ordinate entry to the difference in X coordinate then the 

difference in the Y coordinate, with the two sharing a common point of origin. 

• Station-Offset, to set the order of ordinate entry to station identification then offset 

value, with both sharing a common point of origin 

 The delivered methods are those configured by default. These defaults can be edited, removed, 

or additional methods may be added. 
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CIVIL CELLS 

As defined in the Bentley Civil Tools help files: 

“A civil cell is a collection of civil elements - geometry, templates, and terrain models - which 

can be placed repeatedly in a design. The collection of civil elements will have been created 

relative to one or more reference elements. When you place the civil cell, you choose the new 

reference elements, and a new collection of civil elements is then created relative to them. A civil 

cell can therefore be thought of as a copy of the original collection of civil elements, relative to 

the geometry of the new reference elements. Civil cells can be 2D or 3D. They can consist of 2D 

(plan) elements only, or 3D elements (2D elements with profiles), and can include terrains, 

linear templates, area templates, and simple corridors. 

When the new civil elements are created, all of the rules associated to them are also created. 

This means that the new civil elements retain their relationships, both with each other and with 

the reference elements, and therefore know how to react when these relationships change. In 

addition, the Civil and MicroStation toolsets can still be used on the new civil elements, to adjust 

and further refine the design as required, because there is no difference between a civil element 

created by a civil tool, and one created by placing a civil cell. 

Civil cells can save a lot of time and effort, because they replicate the complete series of steps 

needed to create the civil elements. They also help to ensure compliance with design standards, 

by making a civil cell available to the design team.  

EXERCISE OVERVIEW – 2D PLANIMETRICS 

2.8 Preparation for 2D Plans 

2.9 BL98 Milling Limits 

2.10 BL98 Widening 

2.11 BL98 Widening Taper Line 

2.12 For SR61 New Construction Template Lines 

2.13 Add Right Turn lane on BL98 

2.14 Add the School Entrance Right Turn Lane off BL98 Intersection 

2.15 Create/Edit the Intersection Curve Radii 

2.16 Trim Back Sidewalk and Curb Lines to the Curve Radii 

2.17 Use Civil Cell Technology to Place Curb and Sidewalk Around the Radii 

2.18 Create a Custom Civil Cell for Other Radii 

2.19 Place Left Turn with Traffic Separator 

2.20 Place Right Turn Island 

2.21 For BL98 Intersection Crosswalks Lines 

2.22 Create BL98 Turnouts 

2.23 For BL98 Intersection Shoulders 

2.24 For Friendship Intersection 
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Exercise 2.8 Preparation for 2D Plans 

 Create the DSGNRD01.dgn file from the FDOT Tab under the Actions Group using the Create File Tool 

(This tool is always the starting point to create QC compliant design files for your workset/project.  

OPENROADS MODELING>FDOT>ACTIONS>Create File 
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Exercise 2.9 BL98 Milling Limits 

In this exercise the existing pavement edge lines from the TOPORD or SURVRD file are copied to be used as 

the Milling Lines for the proposed improvements. If the SURVRD does not exist and you only have a  TOPORD 

skip to step 5. 

 Use the Attach Survey Reference from the FDOT Tab within the Roadway Tools Group.  (This tool will 

attach a SURVRD file 4 times with different Logical names of TOPO, GDTM, UTEX, DREX which apply 

to different level filters.)  

OPENROADS MODELING>FDOT>ROADWAY>Attach Survey Reference 

 

 Once the SURVRD is attached, open your Reference Dialog (Function Key F9) and Detach the 
reference files with logical names of GDTM, UTEX, DREX. This will only leave the TOPO. 

 Now we need to copy or merge the elements that are on the PavtAsphalt_ep level. This can be 
done by using the Copy Reference Levels tool from the FDOT Tab with in the Roadway Tools 
Group  

OPENROADS MODELING>FDOT>ACTIONS>Copy Reference Levels 
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 This will open a dialog for the Copy Reference File Levels tool. On the left side of the dialog choose 

PavtAsphalt_ep level. Then click on the plus  to add the level to the right side of the dialog. 
Click the process button to merge/copy the elements with this level in to the file. 

 

 This step if no SURVD Exists Use OpenRoads References (Function Key F9) to attach and 
display the TOPORD01 and RWDTRD01 Reference files. 

 

  Use OpenRoads Level Display to turn OFF all the TOPORD01 Levels except the PavtAsphalt_ep.  

 Use the  Geometry Tab and the Horizontal Group, Line Between Points tool.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 
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 Create a PavementMilling ML line across the existing intersection of SR61 and BL98. 

  

 Use OpenRoads Break Element on the PavtAsphalt_ep line string elements where the new 

PavementMilling(ML) line intersects. 

 

 Repeat these steps for the other side roads along BL98. 
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 Create a Selection Set of the PavtAsphalt_ep by level. This can be done with the right click function of the 

mouse, by holding down and Selecting All On Level By Element. Then selecting an element.  

 

a. Subtract out of the Selection Set the Intersection lines at SR61; these will not be PavementMilling 

ML lines. 

 

b. Also subtract out of the Selection Set the Intersection lines at Friendship Road. 
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 Use the Geometry Tab and the General Tools Group, Click on the Standards button to bring up a drop down 

that has the Set Feature Definition tool.  

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Standards>Set Feature 

Definition 

 

 Data point to change the elements to the Feature Definition, Pavement Milling ML. 

 

 Change the Selector tool back to New and verify the New Feature Definition by hovering over a line until 

the Context Menu displays. 
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Exercise 2.10 BL98 Widening 

Before we start, the ALGNRD will need to be attached as a reference into the DSGNRD file. Making sure when 

you attach the ALGNRD it is the Default Model. With a Detail scale of 1”=50’.   

In this exercise, the proposed Pavement Lines used for widening on BL98 are created at the following locations: 

 

 

 

 

 

 

 

 

 

 Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located in the Offsets 

and Tapers button.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

  

a. Select the BL98 line at the prompt to Locate Element. 

 
START 

STATION 
OFFSET LENGTH 

FEATURE 

NAME 

1 28+00 16 feet 500 feet          SW_EOPA 

2 33+00 32 feet 600 feet SE_EOPA 

3 30+00 -24 feet 300 feet NW_EOPA 

4 33+00 -24 feet 1000 feet NE_EOPA 
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b. Fill in the Single Offset Partial dialog as shown below. 

   

c. Data point in the View to accept the Offset. 

d. Data point in the View to accept Length. 

  

e. Data Point in the View to accept No at the Mirror option prompt. 

 Repeat this procedure for each of the Pavement Asphalt EOPA widening lines diagram and table above.  
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Exercise 2.11 BL98 Widening Taper Line 

In This exercise a tapered Pavement Asphalt EOPA line off BL98 is created at the following location.  

Select Alt to enter the End Station. 

 

 Toggle On the Civil AccuDraw. 

 Use the Geometry Tab and the Horizontal Group, to select Variable Offset Taper tool located in the Offsets 

and Tapers button.  

OPENROADS MODELING>GENERAL >HORIZONTAL>Offsets and Tapers>Variable 

Offset Taper 

 

 Select the BL98 element to offset from. 

 Enter the Station at 39+00 and select Enter to lock the value. 

 Tab to the Offset, enter 20 and select Enter to lock the value.  

START 

STATION 

START 

OFFSET 
END STATION END OFFSET 

FEATURE 

NAME 

39+00 20 feet Alt to end Station Lock Snap Nearest EOPA_TAPER 
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 Data Point in the View to set the first point. 

 

 Select Alt key to lock the End Station value. 

 Set the AccuSnap tool to Nearest, hover over the right Pavment Milling ML until the Snap Mode displays. 

 

 Data Point to place the second point and complete the command.   
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Exercise 2.12 For SR61 New Construction Template Lines 

First, it is necessary to create a Template Limits line for the Project Typical FDM Civil Cell. This is a Construction 

type element which is used to define the Begin and End Station limits.  

 Use the Geometry Tab and the Horizontal Group, to select the Single Offset Partial tool. OPENROADS 

MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single Offset Partial 

 

 Create a Feature line, Const Lines Green. 

a. Select the SR61 Centerline CL. 

b. Set the Offset to 10.00. 

c. For the first point, set AccuSnap to Intersection and select the intersection of SR61 and BL98. 
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d. For the second point, zoom out to the first intersection after the end of the SR61 curve and snap to 

the right Pavement Milling ML of existing SR61 <OR> Key in Station 716+50. 

 

 Use Intersect Snap and to place first point and Key Point snap for the second point.   

 Use the Model Detailing Tab and the Civil Cells Group, to find the Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

   

 Navigate to the FDOT_2D-FDM_Exhibit_Lines.dgnlib, and select 306-5 Exhibit civil cell to place. 

 

a. Click OK and follow the prompts to complete the Place Civil Cell command. 
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b. Locate Reference Element, select the Green 

Const Line. 

 Use the tab key to after clicking on an element to get to 
the last place Green Const Line. 

c. Reset to Skip View Alternates. 

d. Data point to accept Civil Cell Placement 

 

 

 

 

 

 

 

 

 Change the Front Sidewalk Utility Strip Width to 0ft and 

verify that the Sidewalk Width is set  to 6ft,  

a. Select the Sidewalk Front FSW Feature and zoom to find the Context Menu near the middle of 

the element. 

 

b. Change the SidewalkFront Dimension from 4 to 0. 

c. Verify that the SidewalkBack is set to 6.  

d. Repeat this for both sides of the roadway.  
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Exercise 2.13 Add Right Turn Lane on BL98  

This exercise uses Civil Cells to add a right turn lane to the BL98. 

 Use Model Detailing Tab and the Civil Cells Group,  Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

   

 From the Place Civil Cell dialog, navigate to the FDOT _2D-Intersection_Details.dgnlib and select Right 

Turn Lane. 

 

 At the prompt, for the first Reference, select the widening Pavement Asphalt EOPA line. 

 For the second Reference, select the SR61 Right EOP Out Pavement Asphalt EOPA. 

 Reset to Skip Elements to View Alternatives. 

 Data point to accept Civil Cell Placement. The right turn lane is added. 
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 Edit the storage length for first Right Turn Lane placed, select the tangent line and change the Length from 

200 to 500 feet. 

 

 Use OpenRoads Trim to Intersection to correct the Pavement Asphalt EOPA lines. 

Exercise 2.14 Add the School Entrance Right Turn Lane off BL98 Intersection 

 Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located in the Offsets 

and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

 Create the side road Pavement Asphalt EOPA opposite SR61 left offset -23 feet.  

a. For the beginning, snap to beginning of SR61.  

b. For the end, snap to the BL98 widening line end point at SR61.  

c. Uncheck Mirror to set to No. 
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 For the opposite side, use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool 

located in the Offsets and Tapers button.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

 Create the side road Pavement Asphalt EOPA opposite SR61 Left Offset 39 feet.  

a. For the beginning, snap to beginning of SR61. 

b. For the end, snap to the BL98 widening line end point at SR61.  

c. Uncheck Mirror to set to No. 

 If necessary, Let the tool place the line on the opposite side and edit it after it is placed  

 

 Add another Right Turn Lane Civil Cell on the opposite side of the intersection. 

 

a. At the prompt, for the first Reference, select the widening Pavement Asphalt EOPA line. 
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b. For the second Reference, select the intersection Pavement Asphalt EOPA line. 

 

c. Data point to accept Civil Cell Placement. The Right Turn Lane is added. 

 Click on the Select Tool Set icon to exit the Place Civil Cell command <OR> F6 Function Key. 

 

 Edit the storage length for the second Right Turn Lane placed, select the tangent line and change the Length 

from 200 to 365 feet. Verify the Change the lane width is -16 feet. 
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Exercise 2.15 Create/Edit the Intersection Curve Radii 

 Use the Geometry Tab and the Horizontal Group, to select the Simple Arc tool located in the ARCS button 

then the drop down of Arc Between Elements.  

 

 Create/Edit the Curve returns. 

 Select Feature Definition, Pavement Asphalt EOPA to place remaining curve radii.  

 Follow the cursor prompt to select the two Roadway Pavement Asphalt EOPA reference lines.  

 Rotating the view along the BL98 BaseLine will set the Top of the screen as North giving a quandrant as 
shown below. 

 Select the two Pavement Asphalt EOPA in each quadrant. Use the value shown and trim both for each of 
the following quadrants:  NorthWest 110 feet, 

NorthEast 60 feet,  
SouthWest 60 feet,  
SouthEast 60 feet 
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Exercise 2.16 Trim Back Sidewalk and Curb Lines to the Curve Radii 

This exercise takes advantage of design intent to modify the curb and sidewalk lines off SR61 to the new curve 

radius end point. 

 Select the LT_PVT_EOP_IN line (Pavement Asphalt EOPA Feature). 

 

 When the Context Manipulators display, zoom into the beginning point and select the Start Station handle 

OR the Station value to move the end. 

 



Chapter 2 2D DESIGN GEOMETRICS WORKFLOW ____________________________ 2D Planimetrics: Civil Geometry, Civil Cells 

2-58  ©2020 FDOT FDOTCONNECT for ORD Workflows 

 Drag the handle while zooming out and select the End Radius point to move the point.  

 

 Notice the results. The curb and sidewalk move as one because of the built in design intent relationship. 

 

 Repeat these steps to move the RT_PVT_EOP_IN line  (Pavement Asphalt EOPA Feature) back to the curve 

radius on the right Roadway. 
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Exercise 2.17 Use Civil Cell Technology to Place Curb and Sidewalk Around the Radii 

 Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool.  

OPENROADS MODELING>MODELING DETAILING>Place Civil Cell 

  

 Navigate to the FDOT _2D-Curb_Lines_And_Endings.dgnlib and select the Curb Lines Type F civil cell. 

  

 At the prompt, select the NW_EOPA radius line, reset to View Alternates and then data point to accept the 

Civil Cell Placement. 
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  Navigate back to the Place Civil cell dialog select the SideWalk Civil cell from the the FDOT _2D-

Curb_Lines_And_Endings.dgnlib. Place this civil cell off of the back of curb line that you just placed in the 

previous step. 

  

 Edit the SidewalkBack line from -5 to -6 feet from the SidewalkFront line of the element. Also the 

SidewalkFront needs to be set from -4 to 0 feet. 

 

Exercise 2.18 Create a Custom Civil Cell for Other Radii 

 From the Model Detailing Tab and the Civil Cells Group, select the Drop Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Drop Civil Cell 
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 Select the SidewalkLines Civil Cell in the View and data point to drop the Civil Cell. Repeat this for the Curb 

Civil Cell. 

 Move the cursor over the curb or sidewalk lines to see it highlight 

 

 Use Civil Cells, Create Civil Cell tool. This can be found in the Model Detailing Tab and the Civil Cells 

Group of the Ribbon.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Create Civil Cell 

 

a. Enter the Civil Cell Name: Custom CurbandSidewalkLines. 

 

b. Data point to accept the new Name. 

c. At the prompt, locate Reference Element and select the NW_EOPA line. 

 

d. Reset to Locate Reference Element. 

e. Reset to Optional Reference. 

f. Data Point to accept Civil Cell. 
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 Use the new Civil Cell to place for the other Radii; use Place Civil Cell, This can be found in the Model 

Detailing Tab and the Civil Cells Group of the Ribbon.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell. 

    

a. If the Custom CurbandSidewalkLines is not active, navigate to the Active DGN and select it from 

the list. Click OK. 

 

b. At the prompt, select the NE_EOPA Radius line. 
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c. At the prompt, select Element to View Alternatives, move the cursor over the EOPA line and click 

on the Arrow to reflect the Civil Cell to the correct side. 

 

d. Reset to View alternates.  

e. Data Point to accept the Civil Cell Placement. 

 

 Repeat these steps to place the Custom CurbandSidewalkLines Civil Cell on the NE EOPA Radius. 

  

 Leave the SE Radius without curb and sidewalk. 
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Exercise 2.19 Place Left Turn with Traffic Separator 

 Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

a. Navigate to the FDOT _Intersections.dgnlib and select Left Turn with TS civil cell. 

 

b. At the Locate Reference Element Centerline, select the BL98 line in the View. 
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c. At the Locate Reference Element Pavement Asphalt EOPA, select the RT_PVT_EOP_IN line in 

the View. 

 For the direction of travel l, this is always the left median EOP line 

 

d. Click on the Arrow of both Reference Elements to View Alternates, when the Green Turning 

Radius and Traffic Separator are both in the correct place, Reset to skip. 
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e. Data point to accept the Civil Cell Placement and view the left turn lane on SR61 at BL98 

Intersection. 

 

 Use OpenRoads Trim to Intersection tool. A quick way to find a tool is to use the search ribbon.  

 

 Trim the curb median elements at the begin taper as shown. 
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 Use OpenRoads Trim to Element tool. Which can found in the Drawing Tab, and the Modify Group 

 

 Trim the elements at the Curb Median lines at the Traffic Separator as shown, leave the green line. 

 

 View the placed left turn, change the Turning Radius from 100 feet to 75 feet.  
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 View the placed left turn, change the Storage Length from 200 feet to 300 feet.  

 Select the green line, then select the length text.  

 

 Zoom to the Turning Radius Offset Dimension, change the value from -1 feet to -4 feet.  
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Exercise 2.20 Place Right Turn Island 

 Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

 Navigate to the FDOT_2D-Intersection_Details.dgnlib, select Right Turn Island. Click OK. 

  

 Select the first Pavement Asphalt EOPA lines.  
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 Select the second Pavement Asphalt EOPA line. 

 

 Reset to Skip Alternates. 

 Data Point to accept the Civil Cell. 

 

➢ Change the Right Turn Island Parameters 

 Change Const Lines Blue Dashed Arc Radius from 110 feet to 126 feet. 
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 Check Const Lines Blue Dashed Begin Arc Offset is -18 feet. 

   

 Check Const Lines Blue Dashed End Arc Offset is -16 feet. 

  

 Change the straight Const Lines Blue Dashed SR61 EOP Offset from 1 foot to -16 feet. 
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 Check Const Lines Blue Dashed BL98 EOP Offset is -16 feet. 

 

 Change Island EOPA Offset from the Const Lines Blue Dashed BL98 from -5 feet to -2 feet. 

 

 Change Island EOPA Offset from the Const Lines Blue Dashed SR61 from 1 foot to 6 feet. 
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 Change Island Radii to 4 feet. 

 

 Change the Island ingress Offset -4 feet and Island Egress Offset -3 feet. 

 

 Move the Offset handles to the Radius Point. 
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 Change the Active Level to Miscellaneous0. 

  

 Use the OpenRoads Crate Region Flood tool, this tool can be found by switching to the Drawing Workflow 

and then the Home Tab and with in the Groups Group will be the Create Region  

DRAWING>HOME>GROUP>Create Region 

 Select the Center of the Island, and then data point to accept the closed element. 
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 Use the OpenRoads Select tool to view the properties of the new island. Record the Area _____. 

 

 View the modified Right Turn Island. 
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Exercise 2.21 For BL98 Intersection Crosswalks Lines 

 Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located in the Offsets 

and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

 Create a Partial Offset line from BL98 -52 feet across the intersection. Use Feature Definition Const Lines 

Blue Dash and Name ConstLineA. 

 

 Use Geometry Tab and the Horizontal Group, to select the Line Between Points tool. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line Between Points 
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 Create a line from the curve center to the midpoint of the Island Radius EOP.  Use Feature Definition Const 

Lines Blue Dash and Name Line B. 

 

 Use the Geometry Tab and the Horizontal Group, to select Single Offset Partial tool located in the Offsets 

and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Partial 

 

 Create a Partial Offset line from SR61 across the intersection.  Use Feature Definition Const Lines Blue 

Dash and Name ConstLineC.  

 Snap to the mid-point of the radii. 

 

Note Use these lines in later exercises to place 3D Sidewalk Ramp Civil Cells.  
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Exercise 2.22 Create BL98 Turnouts 

In this exercise the additional rural turnouts can be added to BL98. 

 Use the Geometry Tab and the Horizontal Group, to select Single Offset Entire  

Element tool located in the Offsets and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single 

Offset Entire Element 

  

a. Select the CenterLine of the second Turnout. (This Turnout is at Sta. 39+00.00 of BL98) 

  

b. Accept the -20 feet Offset and Mirror. 
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 Use the Geometry Tab and the Horizontal Group, to select the Simple Arc tool located in the ARCS button 

then the drop down of Arc Between Elements.  

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Arcs>Arc Between Elements>Simple Arc 

 

c. In the Simple Arc tool set Trim/Extend to Both, then set the Radius to 25.0’. Be sure to set a Feature 

Definition of Pavement Asphalt EOPA. Then place the Radius on both sides.  
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d. Change the Geometry to fit the existing driveway. 

 Use the centerline snap and dimensions to modify the location, length and angle. Use the Offset 
Pavement Asphalt EOPA Dimensions to change the width. 

 

 (EXTRA Exercise) Repeat the steps above to create an addition Turnout as shown below <OR> use the Civil 

Cell, FDOT_2D-Intersection_Details.dgnlib, and Side Road Turnout.  

 First place the Side Road Centerline make sure to go back into the ALGNRD file to adjust the centerline 

feature.  
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Exercise 2.23 For BL98 Intersection Shoulders 

This exercise uses the Pavement Asphalt EOPA to create the 5 feet Shoulder Paved PSHLDR Offset lines.    

 Use the Geometry Tab and the Horizontal Group, to select Single Offset Entire  

Element tool located in the Offsets and Tapers button. 

OPENROADS MODELING>GEOMETRY>HORIZONTAL>Offsets and Tapers>Single Offset Entire 

Element 

 

 Set the Offset to 5 feet and the Feature Definition to Shoulder Paved PSHLDR. 

  

 Select the Pavement Asphalt EOPA lines from the previous steps. 

 Repeat these steps to add the remaining Shoulder lines for the widening along BL98. 

 View the intersection below for complete details. 
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Exercise 2.24 For Friendship Intersection 

 Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool.  

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

a. From the Place Civil Cell dialog, navigate to the FDOT_2D-Intersection_Details.dgnlib and select 

Rural Side Road Turnout. 

 

b. Add Rural Side Road Turn Out civil cell to both sides of the Intersection with Friendship and 

Friendship 2 Centerlines.  

c. Use the trim commands located in the Drawing Tab and the Modify Group, to clean the extra curb 

line and sidewalk lines across the intersection. 

OPENROADS MODELING>DRAWING>MODIFY>Trim to Element 

d. Change all Radii to 35 feet. 

e. Change Friendship2 Side Road Offsets to 20 feet. 

f. Change Centerline Length to 100 feet. This step will need to be done in the ALGNRD File. 
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 Use Model Detailing Tab and the Civil Cells Group, to select the Place Civil Cell tool. 

OPENROADS MODELING>MODEL DETAILING>CIVIL CELLS>Place Civil Cell 

  

g. From the Place Civil Cell dialog, navigate to the FDOT_2D-Intersection_Details.dgnlib and select 

Left Turn w/ Traffic Separator Median. 
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h. For the first Reference element, select the Friendship Rd Centerline. 

 

i. For the second Reference element, select the left median Pavement Asphalt EOPA line. 

 

  



Chapter 2  2D DESIGN GEOMETRICS WORKFLOW ____________________________ 2D Planimetrics: Civil Geometry, Civil Cells 

FDOTCONNECT for ORD Workflows ©2020 FDOT  2-85 

j. Reset to Skip Alternates and data point to accept Civil Cell Placement. 

k. Change the turning Radius to 50 feet. 

l. Change the turning lane storage length to 300 feet. 

 

 Use OpenRoads Trim to Element tool. This can be found using the Drawing Tab and the Modify Group. 

You can also use the Search on the Ribbon. 

OPENROADS MODELING>DRAWING>MODIFY>Trim to Element 

 

 Move the LT_PVT_EOP_IN to the beginning of the Traffic Separator. 

 Use the Const Lines Green as the cut element 
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 Use OpenRoads Trim to Element tool. This can be found using the Drawing Tab and the Modify Group. 

You can also use the Search on the Ribbon. 

OPENROADS MODELING>DRAWING>MODIFY>Trim to Element 

 

 Trim the Curb and EOP lines to the beginning of the median Taper line. 

 

 (EXTRA Exercises) Complete the Intersection with Civil Geometry tools as follows below: 

m. Add Curb lines for each of the Radius.  

n. Trim Sidewalk lines into the Radius Curb lines. There is no sidewalk along SR61 north of 

Friendship Road. 

o. Add Pavement Asphalt EOPA Taper lines from the Intersection Radii at Friendship to the End 

Station of SR61 11 left. 

p. Add Shoulder Paved PSHLDR lines to both sides along the Taper. 
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DESIGN PROFILES 

This chapter will continue to use the OpenRoads Technology Civil Tools, Vertical Geometry.  These exercises 

will provide participants with practice using the Civil Tools.  Using Civil rule-based Feature Definitions assures 

design intent is incorporated into the vertical geometry layout. This will be beneficial for design when changes 

need to be reflected and considered throughout the development process. This will be beneficial for designs when 

alternatives need to be evaluated throughout the development process. 

This chapter introduces important new OpenRoads Technologies for creating vertical geometry line work 

while designing in FDOTCONNECT workspace.   

OPEN PROFILE MODEL  

The Open Profile Model generates an OpenRoads View that presents the desired feature in profile thus enabling 

the Vertical Geometry tools to interact with the chosen feature. 

Open the Civil Tools Task pane to the Vertical Geometry section then click the Open Profile Model icon. Move 

the cursor into the Workspace and note that it is accompanied by a command prompt requesting that you, "Locate 

Plan Element". Select the element with which you wish to work in profile. The cursor is now equipped with a 

prompt that says, "Select or Open View". Data point or left-click in it a view to present a profile of the selected 

element.  If no other view is open, click one of the view icons on the View Groups toolbar then click again in the 

new View. Vertical Geometry tools can then be used to edit/create vertical profile data in the design. 

CIVIL GEOMETRY - DESIGN INTENT 

As defined in the Bentley Civil Tools help file: 

“Design intent builds associations and relationships between civil elements. Object information 

(how, where, and by what method it was created) is stored with the object to insure the original 

intent is retained and honored in the design. If an element is modified, any related elements will 

recreate themselves based on these stored relationships. 

Civil Geometry or rule-base elements are created intelligently as the tools are used and elements are constructed. 

The FDOTCONNECT Workspace and design development workflow is highly dependent on using Civil 

Geometry for the 2D plan layout rather than traditional MicroStation place elements tools. 

Design Geometrics and Criteria FDOT Design Manual (FDM), Part 2 Chapter 210 

Design Speed 45 MPH 

Facility Low Speed Desired Length 

Maximum Tangent Deflection w/out Curve 1 Degree   Section 210.8.1 

Minimum Horizontal Radius 694 feet  Table 210.9.2 

Minimum Length of Curve 675 feet  Table 210.8.1 

Context Class C3 Max Grade Table 210.10.1 

➢ Low Speed Minimum Length – This will give a minimum Radius at Max Super (emax = .05) 

➢ Low Speed Desired Length – This will give a desired length of curve at Normal Crown. 

Note Refer to the FDM for Tables 
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EXERCISE OVERVIEW - PROFILES 

2.25  Preparation for SR61 Profile 

2.26 Create SR61 Profile 

2.27 Edit SR61 Profile 

2.28 BL98 Profile 

2.29 Friendship Profile 

Exercise 2.25 Preparation for SR61 Profile 

 Open the ALGNRD01.dgn that was created in Exercise 2.1.    C:\WorkSets\FDOT\22049555201\roadway. 

 From the Function key F9 (toggles on the Reference Dialog) to view the attached files: Turn the display off 

on all the reference files except the SURVRD file with a logical name of GDTM. This file will be used to 

create Profiles of the Existing Ground. 

 

Note If the SURVRD file exists, the SURVRD01 -GTMRD logical can be used 

 Once you have the turned off the SURVRD files, we now need to set the terrain Active. To do this select the 

boundary to bring up the context menu and select the second icon in the menu. 

  

Note Setting the terrain to Active will create a new Model that is 3D we will use this Model to view our Profiles 

  



Chapter 2  2D DESIGN GEOMETRICS WORKFLOW __________________________________________________ Design Profiles 

FDOTCONNECT for ORD Workflows ©2020 FDOT  2-89 

 To set up the correct views to design profiles we will use the View Controls located with the right click and 

hold function of the Right mouse. Right Click and Hold on the mouse and navigate to the View Control then 

arrow over to bring up a second dialog to find different view control functions select on the (3 Views 

Plan/Profile/3D) then follow the prompts by the cursor to complete. 

 

 At the cursor prompt, select the OK then it will ask you to select a plan element this will be the SR61 

Centerline. Once you are done your view windows should look like this. 
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Exercise 2.26 Create SR61 Profile 

In this exercise, several Vertical Geometry tools are used to create a proposed profile for SR61. 

 Use the Geometry Tab and the Vertical Group of the OpenRoads Modeling WorkFlow.  

OPENROADS MODELING>GEOMETRY>VERTICAL 

 

 From the previous exercise select View 4 to make the Profile window active. 

 

 Use the  Geometry Tab and the Vertical Group, to select the Define Profiles by Best Fit tool that is located 

within the Complex Geometry pull down.  

OPENROADS MODELING>GEOMETRY>VERTICAL>Complex Geometry>Define Profile 

By Best Fit 
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a. At the cursor prompt, data point to Make Complex Element option.  Enter the Profile Name , SR61-

PR, and then data point on the green line in the profile. 

 

b. Follow the prompts to enter the Best Fit Parameters as shown. Make sure to pick the Feature 

Definition of CenterLine. 
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 Using the Design Standards Toolbar that is already docked at the top of the screen. 

  

 On the Design Standards Toolbar, using the second drop down list navigate to the C2T C3 C4 C&G 

(FDOT_DesignGeometrics Criteria Design Library and select 45 MPH.  Toggle On the Active Design 

Standard. 

 Be sure to set the left field (Horizontal Design Standard) in order to set the right field (Vertical Desgin 
Stnadard)   to 45 MPH 

  

 Use the Design Standards Toolbar,to select the Set Design Standard tool. 

  

a. At the prompt, select the Best Fit Profile created in the previous steps.  The profile now has a 

Vertical Design Standard rule placed on it. 

b. Using the Element Select Tool,  select the profile element and view its properties in the Element 

Information dialog. 
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 Use the Civil Message Center tool that is located on the Geometry Tab and General Tools Group in the 

Standards drop down menu.  

 

a. The Civil Message Center dialog displays to view the results.  

Note It may be docked at the bottom of the screen, click on the Tab 

  

b. In the Civil Message Center dialog, select on the MicroStation tab. This will toggle Off all the 

general messages for MicroStation and leave only Error messages and Warnings in the list. 

  

c. In the Civil Message Center, review the Errors and Warnings. 
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d. Select the first error, then right click over the error and select Zoom To from the popup box. 

  

e. Notice the Error is now centered in the profile view.  Hover the cursor over the Error icon to display 

the Error Message description. 

  

Note The values are given in whole stations, i.e. 3.5 station equals 350 feet. 

 Since there can be a number of different situations for both the horizontal and vertical curve depending on 

Context classification and Desi.gn Speed, we will now set the vertical in the Explorer Dialog.  

a. Using the Explorer Dialog (Function Key F11) if you do not have it docked. Navigate to the 

OpenRoads Standards Tab then click on Standards to open the current file you are in to see the 

Design Standards Category to view the Design Standard applied the Alignments in the file. 
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b. Select the Horizontal Design Section to see which design standard is applied to the Alignment, next 

select the desired speed. Now using the Ctrl+I keys to bring up the properties dialog lets link a 

vertical design speed to the horizontal. 

 

 Use the Design Standards Toolbar that is docked to toggle on the Set Design Standards. 

 

 At the prompt, select the Best Fit Profile created in the previous steps.  Notice the Error icons are no longer 

displayed. 

  

Note A new tool to OpenRoads Designer is the Table Editor Tool. This tool can be found on the Geometry Tab 
and the Common Tools Group. With this tool a selection of the alignment (Horizontal or Vertical) will bring 
up a table for easy editing. 

OPENROADS MODELING>GEOMETRY>COMMON TOOLS>Table Editor 
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Exercise 2.27 Edit SR61 Profile  

This exercise changes the profile using Civil AccuDraw and MicroStation Modify Element. 

➢ Edit the Best Fit Profile  

In order to edit this profile, because it was created from the “Profile by BestFit”, the rule must first be removed. 

 Select the Profile Element and hover over the element to display the Context Menu.  

 

 Select the Convert to Profile Rule tool.  
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➢ Delete PIs 

 Use MicroStation Modify, Delete Vertex tool. This tool can be found in the Drawing Tab and the Modify 

Group 

OPENROADS MODELING>DRAWING>MODIFY>Delete Vertex 

 

 Zoom to the beginning of the Profile and delete the first two Vertical Elements. 
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➢ Create Profile with Place Vertical Line 

New vertical civil profile elements are added to match the existing profile across US98. 

 Use Geometry Tab and the Vertical Group, to select the Profile Line Between Points tool located in the 

Lines Tools. 

OPENROADS MODELING>GEOMETRY>VERTICAL>Lines>Profile Line Between Points 

 

 Place Line Elements on the Existing Ground points to trace the Profile across BL98. 

Note This is not exact, simply trace a few lines.  

 

 Continue using the Profile Line Between Points tool 

a. Begin at the edge of the existing pavement or connect to the proposed profile line from the step 

above.  
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b. In the Profile Line Between Points dialog, check the length and slope, length of 16 feet and slope 

of -2%. Click a data point in the view to create the line as defined in the dialog.  

   

 

c. Using Line Between Points to join the two profiles, place another Profile line between the “16’ at 

2%” line and the Best Fit Profile. 
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➢ Profile by VPI’s 

 Zoom to the Beginning of the profile, Use the Geometry Tab and the Vertical Group, to select the Profile 

Complex By VPI or PI tool located in the Complex Geometry tool Group. 

OPENROADS MODELING>GEOMETRY>VERTICAL>Complex Geometry>Profile Complex By PI 

 

 Toggle OFF the Active Design Standard, set the Curve length to 50 feet. 

 Check that the Vertical Curve Type is set to Parabola 

 

 Start by snapping to the Beginning Point on the ground and complete the Profile Segment as shown below. 

 This is not exact, snap to 3 points 
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 Zoom to the End of the Profile, select the Line and move the last End Point to snap to the Existing Ground. 

 

 Click on the solid ball manipulator at the end of the line to move it in both directions 
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➢ Complex Profile Elements 

 Use Geometry Tab and the Vertical Group, to select the Profile Complex by Elements tool located within 

the Complex Geometry tool Group. 

OPENROADS MODELING>GEOMETRY>VERTICAL>Complex Geometry>Profile 

Complex By Elements 

 

 Key-in the name SR61_PR on the dialog and Start at the Beginning Profile line and create a new Connected 

Profile. 

 On the Profile Complex by Element tool setting, enter the Feature Name. This is the Profile Name assigned 
to the Profile. 
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➢ Profile Report 

 Use the Geometry Tab and the General Tolls Group, to select the Profile Report tool located within the 

Reports tool Group. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Reports>Profile Report 

   

<OR> With the Profile selected, hover over the element to display the Context Menu and 

select the Profile Report. 

   



Chapter 2 2D DESIGN GEOMETRICS WORKFLOW __________________________________________________ Design Profiles 

2-104  ©2020 FDOT FDOTCONNECT for ORD Workflows 

 The Bentley Civil Report browser displays the Vertical Alignment Review Report for the Profile. Close 

the Civil Report browser. 

 

 Use Geometry Tab and the Vertical Group, to select the Set Active Profile tool.  

 

<OR> With the Profile selected, hover over the element to display the Context Menu and 

select Set Active Profile.   

Note The ALGNRD file is your single source for both your Horizontal and Vertical Geometry. This file is now 
more important than ever in your design. This file will be referenced in to your DSGNRD and MODLRD 
files to control the 2D Planimetrics (DSGNRDxx.dgn) and your Corridor (MODLRDXX.dgn). 

➢ Optional Export Profile 

 Use the Geometry Tab and the General Tools Group, to select the Export Geometry tool located within the 

Import/Export tool Group. 

OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Export Geometry 

 

 Always check that the profile has a Feature Name before saving to the LandXML file 

 Select the SR61 Horizontal Alignment and save as SR61_Alignment.xml for a backup. 
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Exercise 2.28 BL98 Profile 

 With the BL98 alignment selected in the Plan View, hover over the element to display the Context Menu 

and select the Open Profile Model. (Optional Method - Using the Right Click Menu under View Control 

navigate and pick 2 Views Plan\Profile then follow the prompts to setup a Plan and Profile views.) 

 Select View 3 to view the Existing Ground Profile for the mainline BL98 Centerline. 

 

 With the Profile selected, hover over the element to display the Context Menu and select the first icon 

Properties 

 In the name field enter BL98_EX 

 

 With the Profile selected, hover over the element to display the Context Menu and select Set As Active 

Profile.  
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 Use the Geometry Tab and the General Tools Group, to select the Export Geometry tool, select the 

BL98_EX plan element and save as a LandXML file. (Ex. BL98_EX.xml).  

 OPENROADS MODELING>GEOMETRY>GENERAL TOOLS>Import/Export>Export Geometry 

 

 

  



Chapter 2  2D DESIGN GEOMETRICS WORKFLOW __________________________________________________ Design Profiles 

FDOTCONNECT for ORD Workflows ©2020 FDOT  2-107 

Exercise 2.29 Friendship Profile 

 With the Friendship alignment selected in the Plan View, hover over the element to display the Context 
Menu and select the Open Profile Model. (Optional Method - Using the Right Click Menu under View 

Control navigate and pick 2 Views Plan\Profile then follow the prompts to setup a Plan and Profile views.) 

 

 Select View 3 to view the Existing Ground Profile for the mainline Friendship Centerline. 
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 With the Profile selected, hover over the element to display the Context Menu and select Set As Active 

Profile.  

  

 Repeat the steps for Friendship2 Rd. 

 Open View 2 using the F2 Function Key to see the 3D alignment cernterlines for the project (Optional Method 

- Using the Right Click Menu under View Control navigate and pick 2 Views Plan\Profile then follow the 

prompts to setup a Plan and Profile views.) 

 Notice the 3D lines displays in View 2. 
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3 3D ROADWAY MODELING 
WORKFLOW 

BASIC CORRIDOR MODELING OVERVIEW 

As defined in the Bentley Civil Help:  

“The Corridor Modeling toolset is a group of highly interactive commands to create new design 
surfaces that represent a new roadway or other type of surface. Tools for creation, modification, 
management, and report functions are supported. 

Corridor Modeling tools aggregates a variety of civil data. The geometry is created with the 

Horizontal and Vertical Geometry tools, while the existing ground is defined by a MicroStation 

mesh or Civil Terrain Model. Plan view elements, such as edges of pavement, shoulders, curbs, 

etc. can be 2D or 3D. Superelevation information is defined within a design file using standards 

or imported data. Templates are utilized from one or more template libraries. 

Reference files can be used extensively with Corridor Modeling. On a simple project, the data 

may be all in one file; larger projects may have geometry in one file, plan view graphics in a 

second, terrain in another, superelevation in a fourth and the actual model in a fifth. All files 

can reference the others, to present a complete picture of the project.  

When working with Corridor Modeling, you can draw in 2D or 3D. When using 2D (such as for 

plan-view graphics), a 3D view is automatically created and maintained. For example, when a 

vertical geometry element is initially defined for a horizontal geometry element, the Default-3D 

model is created, if there isn’t one already. The 3D baseline (combination of horizontal and 

vertical element) is drawn into the 3D model. As template drops are added, and progressed, they 

are added to the 3D model automatically.  

When starting to create a corridor, basic information can be used. A single template can be 

used, along with preliminary geometry and a high level terrain model. As the design progresses, 

more detail can be added. Instead of a single template drop, perhaps more templates better 

define the roadway. Transitions can be added to smoothly move from one template to another. 

There may be multiple roadways all interconnected using the target aliasing tools. All the while, 

as changes are made, the corridor model is updating, so you see up-to-the minute results. Simple 

projects may not require all the tools, and a basic corridor model may be sufficient. But all the 

tools are available to handle basic to complex, small-scale to large-scale projects. 

The following are minimum requirements to use Corridor Modeling. 

• Civil horizontal element  

• Civil vertical element  

• Template stored in a template library 

A terrain model is not required for corridor modeling. If the template includes end conditions and no terrain 

model is defined, the software generates as much of the model as possible but will not complete the end condition 

that ties to ground and no error message is given. 

Corridor models are built at an interval, which determines the level of detail of the model. OpenRoads essentially 

takes the typical section stored in the template and places it every 25’ (or whatever the interval is set to) along 

the alignment in order to build the 3D model. The FDOT CADD manual section 8.4.7 sets forth the maximum 

required intervals for a corridor, depending on the Context Classification of the roadway. Corridors can certainly 

be built at a more frequent interval, but this is at the expense of more computing power (RAM, disk space, and 

CPU). To optimize the model, the interval spacing should only be made tighter than the maximum when needed. 
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For this project, the Context Classification is C3C. An excerpt from the table in the CADD manual is shown 

below, showing the corridor interval requirement for C3C. The interval can be set to the tangent requirement as 

long as the design stage used decreases the interval spacing on curves. 

Maximum Corridor Frequency Interval Spacing (Feet) 

Context Classification Tangent Curve Intersection 

C3C 20 10 5 

CORRIDOR MODELING PLANNING 

It is recommended to plan out the 3D modeling approach on a project.  Some have referred to this a Model 

Management Plan.  This plan will attempt to outline the following: 

• Determine how to break up the project into logical independent corridors 

• Determine which sections of the project are needed for detail modeling and surface modeling 

• Determine the files and filenames to be used for corridors and details.  

Note The project 3D Model may be in separate files or all combined into one file.: The FDOT file defined to be 
used for Corridor and Detail Models is MODLRDxx.  

Below is a sample diagram of a typical Model Management Plan: 

 

EXERCISE OVERVIEW – BASIC CORRIDOR MODELING 

3.1 Prepare to Create Corridor Model for SR61 

3.2 Create Corridor, SR61 

3.3 Create Template, SR61 End Conditions 

3.4 Add Corridor Point Controls, SR61 L and R 

3.5 Add Corridor References, SR61 

3.6 Variable Medians, SR61 Templates 

3.7 Change Corridor Feature Definition, SR61 

3.8 Add Corridor Key Stations, SR61 

3.9 Review Corridor Objects, SR61 
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Exercise 3.1 Prepare to Create Corridor Model for SR61 

 Open the _BlankFile.dgn file of the c:\<Workset Folder>\FDOT\22049555201_CE\ folder in the 

FDOTConnect - Roadway Workspace in OpenRoads Designer. 

 Go to the FDOT ribbon and Choose “Create File.” 

 Create a new MODLRD01.dgn file. Select Wakulla County. Choose Create/Open File. 

 Open the MODLRD01.dgn file. 

 Reference the SURVRD01, ALGNRD01 and DSGNRD01 files. 

 Use the Terrain tab, Set Active tool.  

 

 At the cursor prompt, select the Terrain Boundary green dashed line from the attached SURVRD01 

reference file. This will set the terrain model as Active. 

 Move the cursor over the SR61 Centerline Feature and verify an Active Profile. 

 

 Use the Corridor Modeling, Create Template tool. 

 

 Use the F12 function key to access the Create Template Dialog. 
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 Verify that the correct Template Library is loaded. Close the Create Template dialog. 

 

 To set up the Views for viewing the 2D Plan and 3D Model simultaneously in the FDOTSS4 Workspace, 

Select the F2 Function Key on the keyboard.  This will open an Isometric View of the project. 
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Exercise 3.2 Create Corridor, SR61 

 Use the Corridors, New Corridor tool. 

 

 Select the SR61 Centerline in the Plan View when the “Locate Corridor Baseline” prompt comes up. 

 Reset to accept the Active Profile.  This profile resides with the SR61 Civil Feature Centerline.  

 Enter the Corridor Name, SR61, in the Create Corridor dialog.  

 

 Data point to accept the Name of the Corridor, SR61. The corridor is created AND the integrated Create 
Template Drop dialog launches.  
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Note Once a Corridor is created, a shape boundary is placed in the Plan View representing its outline.  This 
shape is initially placed on the CorrHndlStg1_dp level.  It has several properties which can be seen by 
clicking on the shape and choosing first icon. One of the properties is the Feature Definition (Design Stage).   

  

 Once the Create Template Drop dialog is opened, first select the corridor template to be placed on the 

corridor. Either use the icon on the dialog <OR> select ALT down arrow to pick a template. 
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 Find the SR61 Inside template in the Corridor Templates folder of the active Project Template Library. 

Select it and click “OK.” 

 

 Data point to accept the Template and move to the 

next setting.  

 Continue to define the Create Template Drop dialog 

information entering and accepting the following for 

the SR61 Corridor: 

a. Start – Use keypoint or intersect snap click to 

the ML line on 98, Station 700+23.62 as 

shown on the right. 

b. End – type in Station 715+00 as shown 

below. 

c. Set the Drop Interval to 20 as shown below. 
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 Upon completion of the Corridor Processing bar in the lower right hand side of the OpenRoads status bar, 

the 3D model will be displayed in View 2. 

 

Note Once a Template Drop is created, a shape boundary is placed in the Plan View represent its outline. This 
shape is initially placed on the TmpDrpHndlStg1_dp level. It has several properties which can be seen by 
clicking on the shape and choosing first icon. Properties include the Template Drop Interval and the 
Template Name. 
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➢ Turn 3D Reference File Display Off in the Plan View 

At times the line work in the Plan View can become confusing with 3D lines over top of the 2D lines. This View 

can be simplified by turning the 3D Model Reference file display Off. 

 Data Point somewhere in View 1 to make it active. 

 On the OpenRoads Level Display dialog, navigate to the Ref. MODLRD01.DGN Default-3D file. 

 Right click on the file and un-check the Display option. 

 

  



Chapter 3 3D ROADWAY MODELING WORKFLOW ___________________________________ Basic Corridor Modeling Overview 

3-10 ©2020 FDOT FDOTCONNECT for ORD Workflows  

Exercise 3.3 Create Template, SR 61 End Conditions 

Splitting the template allows more flexibility when adding driveways and side streets, as the end condition 

(outside) template can change at those locations without affecting the mainline. The template for the previous 

exercise only extended to the edge of pavement and did not include curb. In this exercise we will add the curb 

and the end conditions. 

 Use the Corridors, New Corridor tool. 

 Select the SR61 Centerline in the Plan View when the “Locate Corridor Baseline” prompt comes up. 

 Reset to accept the Active Profile.  This profile resides with the SR61 Civil Feature Centerline.  

 Enter the Corridor Name, SR61 R, in the Create Corridor dialog.  

 OpenRoads will continue on to the Create Template Drop command. Either use the icon on the dialog 

<OR> select ALT down arrow to pick a template. 

 

 Pick the SR61 R template in the Corridor Templates folder of the active Project Template Library. 

 Continue to define the Create Template Drop dialog information entering and accepting the following for 

the SR61 Corridor: 

a. Start – Snap to the end of the curb radius return on the right side of SR 61 at the T intersection, 

Station 701+00, as shown below. 
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b. End – Snap to the beginning of the curb radius return on the right side of SR 61 at the intersection, 

Station 714+26.67, as shown below. 

 

c. Set the Drop Interval to 20 and accept the remaining prompts. 

 Repeat Steps 1-7 for the left side. 

a. Name the Corridor SR 61 L and pick the SR 61 L Template 

 

b. Select the start and end points of the template drop based on the curb radius return points on the left 

side of the roadway. The stationing is listed below: 

o Start – Station 701+34.00 

o End – Station 714+29.06 
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 The corridor models will display in the 3D View but will be on top of the previously placed pavement model. 

This will be addressed in Exercise 6.4.  
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Exercise 3.4 Add Corridor Point Control, SR 61 L and R 

 Use the Corridors, Edits>Create Point Control tool. 

 

 Identify the Corridor Boundary handle for the SR 61 R corridor. Continue to define the Create Point 
Control dialog information. 
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 Enter and accept the following for the SR61 R Corridor: 

o Start Station Lock to Start 

o End Station Lock to End 

o Control Description RT_EOP 

o Point  RT__PVT_EOP_OUT 

o Mode Both 

o Control Type Corridor Feature 

 For the Corridor, select a handle on SR 61 corridor developed for 

the inside. 

 For the Reference Feature, select the RT__PVT_EOP_OUT line 

on the SR 61 corridor (inside) in the 3D view, as shown on the 

right. Note: DO NOT use select this with the drop-down as ORD 

currently has a bug where that will cause it to not display 

correctly.  

 Accept the defaults for the remaining items. The 3D view will 

update to move the curb and sidewalk to match the edge of 

pavement of the SR 61 corridor model. 

 Repeat Steps 1 through 4 to set a point control for the SR 61 L 

corridor, with the following differences in the dialog: 

o Control Description: LT_EOP 

o Point: LT_PVT_EOP_OUT 

 For the Reference Feature: select from the dropdown list or select 

the LT__PVT_EOP_OUT line on the SR 61 corridor (inside) in 

the 3D view, as shown on the right. 

 Repeat Step 6 to complete the point control. The model should 

look like below in the 3D view. 
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Exercise 3.5 Add Corridor References, SR61 

Corridor References are related to the template points having a Horizontal Feature Constraint to control the 

location of the point on the corridor. They are 2D graphical Civil Features that need to be added to a corridor.  

For the SR61 corridor a selection of median Civil Features are used for template external references.   

 The SR61 template is designed to target Curb Gutter Type E lines in the median. Hover the cursor over one 

of the median lines to verify that it has the Feature Definition of Curb Gutter Type E. 

  

 Create a selection set of the following 12 features in the plan view: 

o 2 – Pavement Asphalt EOPA lines in the median 

o 4 – Pavement Asphalt EOPA taper lines in the median 

o 2 – Curb Gutter Type E lines in the median 

o 2 – Curb Gutter Type E taper lines in the median   

o 4 – TS Conc Type I 4 ft Wide lines in the median 

 Modeling the TrafSeparator level, do not add the Nose Radius Element to the Selection Set. This will be 
modeled in Chapter 9 with a 3D Civil Cell. 

 Use the Corridors, Add Corridor References tool. 

 

 Identify the Corridor handle and then data point to add the selected lines as listed above to the corridor. 
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 Once the Reference Lines have been added, the Corridor will automatically process to include the new 

Horizontal Feature Constraints. The median features will come in several feet above the pavement, as 

intended on the template. This will be resolved in the next exercise. 

 

Exercise 3.6 Variable Medians, SR61 Templates 

The FDOTConnect.itl file contains some FPM Exhibit Templates which are delivered with variable medians 

included. The median can vary with the following conditions or component sets: 

o Curb Median with or without Left Turns 

o Crossovers at Intersections 

o Traffic Separators with Left Turns 

To properly operate the median condition templates, consider the following: 

• The various median component sets have a parent end condition search lines that targets plan features; e.g. 

Curb Gutter Type E, Pavement Asphalt EOPA. 

• Each of the median components sets are displayed ONLY if the target is found. This is by the Parent/Child 

relationship of the Template components. 

• The LT and RT PGL Handles, or the LT and RT PGL In points, control the overall width of the median and 

can be modified to fit any project. 

• Many of the median components have Horizontal Feature Constraints (HFC) defined to locate the 2D civil 

features and the horizontal range will need to be modified to fit the project. 
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➢ Add Parametric Constraint for Variable Median, SR61 Template  

The templates used have variable median conditions built within that needs to be set in place for the corridor.  

 Use the Corridors, Edits>Create Parametric Constraint tool. 

 

 Identify the Corridor Boundary handle. Continue to define the Create Parametric Constraint dialog 

information. 

 

 Enter and accept the following for the SR61 Corridor:  

o Start Station  Alt for Begin 

o Stop Station  Alt for End 

o Constraint Label  V_Offset 

o Start Value   0.0 

o Stop Value   0.0 

 

 The variable median conditions are placed at the correct location vertically.  This will ensure the median is 

at the correct elevation for the next exercise. 
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Exercise 3.7 Change Corridor Feature Definition, SR61 

The FDOTConnect Workspace includes several Corridor Feature Definitions to help with various tasks for 

Design and 3D Modeling. Depending on the active Feature Definition, processing the Corridor will take longer.  

To optimize model performance, it is recommended that designers wait to change the Feature Definition until 

later in the design process, as each definition is set up with multipliers that decrease the corridor interval spacing.  

For example, the Design stage might be utilized for a 60% submittal, while the Final stage might be utilized for 

the 90% and final submittals. 

 Open the Explorer pane from the Home tab or with the F11 Function Key. 

 

 Select to expand the OpenRoads Standards section and expand the Standards option list. 

 Expand Corridor under Libraries > Feature Definitions > Feature Definition 

(FDOT_Stanrdards_Features.dgnlib (Default)). These Feature Definitions are set up for various Design 

Stages. 
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 Select the Handle of the SR 61 Corridor and locate the Properties icon when the menu displays. 

 

 Select the Properties icon and change the Feature Defintion from 1 PRELIM to 2 DESIGN. 

 

 The Corridor will re-process and the 3D Model will re-draw with a tighter interval. Notice that the outside 

corridors remain unchanged. 
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 Expand the OpenRoads Model section of the Explorer window. 

 Expand MODLRD01.dgn (Default). 

 Expand 1 PRELIM under Corridors. 

 Right click on SR61 L and select “Properties.” 

 Hold down Shift or Ctrl and select SR61 R. The Properties window 

changes to show both Corridors selected.  

 

 

 

 

 

 

 Change the Feature Defintion from 1 PRELIM to 2 DESIGN as 

shown below. The 3D models for the outside corridors should 

redraw with a tighter interval. 
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Exercise 3.8 Add Corridor Key Stations, SR61 

Create Key Station tool is useful to add stations that are not coincident with the template interval.  When the 

median conditions change abruptly, it is desirable to include the station for processing. Otherwise the model may 

have holes or overlaps, which is not desirable when it is used to generate 3D Deliverables for Automated Machine 

Guidance.  

 Use the Corridors, Edits>Create Key Station tool. 

  

 Identify the Corridor Boundary handle of the SR61 Corridor.  

 Use AccuSnap to locate the Plan View CurbMedian / Traffic Separator division line. Snap to a point on 

this line. 

 

 Repeat these steps for both Traffic Separator locations in the Plan View. 
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 Add Key Stations at other transition areas, including where the left turn lane transition begins. If snapping 

directly on the transition point does not work, sometimes a key station is needed immediately before and/or 

after the transition point in order to minimize the size of the hole. 

 (Optional) Rotate the 3D View to a Top-down orientation, as it is sometimes easier to see where to snap to 

in the 3D view.  
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Exercise 3.9 Review Corridor Objects, SR61 

The Corridor Objects dialog is a summary of all Corridor Modeling objects and provides an excellent method 

of managing data. 

 Use the Corridors, Corridor Objects tool. 

 

 Identify the Corridor Boundary handle to open the Corridor Objects dialog. 

 

 Review the various objects on the corridor. If too many key stations were added in the previous step, they 

can be deleted or modified in this dialog. 

➢ Additional Template Edits, SR61 

 Add the sidewalk front and back lines as corridor references to the respective outside corridors. 

 Change the sidewalk buffer from 3 feet to 0 feet on both roadways.  
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SUPERELEVATION 

Superelevation rotates the pavement cross slopes through a curve so that vehicles can maintain stability and speed 

while on a turning roadway. Elevation banking is applied to help offset centrifugal force. Superelevation 

standards also define the transition length required to rotate from a normal crown to a fully banked curve and 

back again.  

Superelevation can be calculated in two ways:  

• Rules-based – using a set of preferences the station and associated cross slopes of the transitions are based 

on design speed, curvature, and other design parameters. As the design progresses and parameters change 

(i.e., design speed exceptions) superelevation can be reprocessed to the revised parameter(s).  

• Import – using a comma separate values (CSV) file to import the station and associated cross slope of each 

transition. In this option, the rules are not utilized; the data is simply applied to the superelevation lanes.  

The result of superelevation is a DGN file of graphic superelevation lanes with cross slope attributes. This file 

can be referenced to a corridor model and associated, so the superelevation transitions are incorporated into the 

corridor model. The superelevation data should be stored in the ALGNRD DGN file, in the Superelevation model.  

DATA NEEDED FOR SUPERELEVATION 

Data Needed for Superelevation (ORD)

Superelevation
eMax:

Low Speed 
(5%)

High Speed 
(10%)

Shared Use 
Path (2%)

Design Speed

18 mph - 70 
mph

Lanes
/Direction

1-2

3

4

Pivot Method

Crown

Edge

Divided Inside

Centerline

 

o Shared Use Path would typically be one of the “Edge” methods (inside, outside, left, right). 

o Undivided roadway would typically be Crown or Centerline. 

o Divided roadway might be “Divided Inside”. 
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SET SUPERELEVATION FLAGS IN TEMPLATE 

Set Superelevation Flags in Template

 

You need your corridor model created before applying superelevation.  In SS4 we could get by with setting 

superelevation flags after calculating superelevation, but in ORD best practice is to set them ahead of time. This 

will allow us to use one of the new features. Before creating superelevation lanes, you will want to make sure to 

set the Superelevation Flags accordingly by lane. Be sure to synchronize with the template library if needed. 

SUPERELEVATION POINTS 

Superelevation Points 

 

o If you’re going to use superelevation by lanes, you can go to “Active Template” and expand 

“Superelevation Points” to see all the points you have turned the superelevation flags on, which 

ORD will use to determine the lanes. 

o There are several new pivot points available in ORD, and to take advantage of them for a divided 

roadway you’ll want to create a null point on the centerline that the others are tied to, so the slope 

can be adjusted from there. Just use a vector offset or slope constraint as appropriate. 
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EXERCISE OVERVIEW – SUPERELEVATION 

3.10 Prepare Alignment File for Superelevation 

3.11 Create Superelevation Sections 

3.12 Create Superelevation Lanes 

3.13 Calculate Superelevation 

3.14 Assign Superelevation to Corridor 

Exercise 3.10 Prepare Alignment File for Superelevation 

 Open ALGNRD01.dgn and switch to the Superelevation model. 

 Reference DSGNRD01_Complete.dgn, MODLRD_Mainline_01.dgn and ALGNRD01.dgn (Default model) 

files. 

Exercise 3.11 Create Superelevation Sections 

Production Support 

Office 

CAD DSuperelevation
Sections

 

 Select Create in the Superelevation section in the Corridors tab. 

 Select the corridor. 

 Name and give the Superelevation feature definition. 

 Minimum tangent length can split it into multiple sections (ie if you have multiple design speeds) based on 
the distance between curves. 

Note Just like in SS4 it goes straight into the create superelevation lanes tool. 
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Exercise 3.12 Create Superelevation Lanes 

Production Support 

Office 

CAD DSuperelevation Lanes

 

Note New feature lets you select your template in order to create superelevation lanes in accordance with the 
lanes in the template. 

 From the superelevation section context menu or in the Corridors tab of the ribbon, choose Create by 

Template. The points will automatically be picked up based on how your template is set up. 

Superelevation Lanes by Template

 

 Pick template. 
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Exercise 3.13 Calculate Superelevation 

Production Support 

Office 

CAD DCalculate 
Superelevation

 

 Go to Corridor tab, Superelevation section. Click “Calculate.” 

 Select FDOT superelevation rule file 

Production Support 

Office 

CAD DCalculate 
Superelevation
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 Select appropriate settings, e selection is “Low Speed,” “High Speed,” or “Shared Use Path” 

Production Support 

Office 

CAD DCalculate 
Superelevation

 

 For Shared Use Path, select “Speed Table” under “L.” 

 For High Speed you need to know the lanes 

Note Design speed varies based on e selection. For high speed we have 30-70. For Shared Use Paths we have 
18 and 30, and for Low Speed we have 25-45. 

Production Support 

Office 

CAD DDesign Speed

 



Chapter 3 3D ROADWAY MODELING WORKFLOW __________________________________________________ Superelevation 

3-30 ©2020 FDOT FDOTCONNECT for ORD Workflows  

Production Support 

Office 

CAD DPivot Method

 

 Select the “Center Line” pivot method. 

 Template needs to be set up in a way that allows for the pivot method (i.e. with a null 
point at the centerline.) 

 (Optional) Open the Superelevation Editor. Close when complete. 

➢ Export and Import Superelevation 

 From the superelevation section context menu, open the Superelevation Report. 
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 Select “SuperelevationToCSV.xsl” Change Format Options to show stationing correctly if desired. 

 

 Select File > Save As… and save the file as “Superelevation.csv.” Change the “Save as type:” to “Text File 

(*.txt)”, then click Save. 

 

 Open the file in Excel, edit some values, and save the file. 

 Open the Superelevation Editor from the Corridors tab. Select the superelevation section at the prompt 

 

 Select all rows and delete. 

 Select “Import Superelevation transitions” as shown on the right, and import the “Superelevation.csv” file.  

 

 This is a good way to make corrections or calculations in Excel if you want to double check that the numbers 
meet the standards.  
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Exercise 3.14 Assign Superelevation to Corridor 

Production Support 

Office 

CAD DAssign to Corridor

 

 Open the MODLRD01.dgn file of the <Workset Folder>\FDOT\22049555201_CE\ folder in the 

FDOTConnect - Roadway Workspace in OpenRoads Designer. 

 Reference in the ALGNRD01.dgn file, Superelevation model, into the 2D model. 

 From the Corridors tab, select “Assign to Corridor.” 

 Select the Superelevation section and then the corridor, Verify the points in the dialog, and it should process 

when you click OK. 

Verify Superelevation

 

 Open a cross section view and verify that the superelevation has been applied. 

 (Optional) If corrections are needed, use the Corridors, Corridor Objects tool and select “Point Controls”. 

Each superelevation lane has been added as a separate point control. 
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4 PLAN DEVELOPMENT 
WORKFLOW FOR CUTTING SHEETS 

KEY SHEET  

The Key Sheet is defined as the first sheet in the contract plans. The Key Sheet describes the project, the contents 

of the plans, and identifies those responsible for preparing the plans. All requirements for the Key Sheet, can be 

found in Part 3, Chapter 302 of the FDOT Design Manual (FDM). 

OBJECTIVES 

• Create a Key Sheet DGN File 

• Setup Key Sheet with All Necessary Information 

EXERCISE OVERVIEW – KEY SHEET 

4.1  Create the Key Sheet 

4.2  Place and Edit the Components of Contract Plan Set List 

4.3  Create and Place the Key Sheet Index 

4.4  Place the Range and Township Map Label 

4.5  Place the Project Location Labels  

4.6  Place the Contract Revision Note (Optional) 

4.7  Index the Key Sheet 

4.8  Create the Plan Sheets 

 

Exercise 4.1 Create the Key Sheet 

In this exercise, the Key Sheet DGN file will be created, the sheet will be placed with a map, and all of the 

necessary information will be added to the sheet. 

 Using the FDOTConnect icon on your desktop, open the MicroStation design file:   

C:\Worksets\FDOT\FLUG_2019\_BlankFile.dgn 
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 On the OpenRoads Modeling Workflow, select Create File, from the FDOT Tab 

  

 The Create File (v 2.0) dialog displays. On the Create File dialog set the Discipline to Roadway and File 

Group to Roadway Files. From the File Type list, select KEYSRD. On the Output File section of the dialog, 

be sure to set the County to Wakulla. Once everything is set up to match the image below, click Create – 

Open File to create and open the Roadway Key Sheet file. Click Close to close the Create File (v 2.0) 
dialog. 

 

 Once in the file, download the PDF county map using the County Maps link on the FDOT Tab. FDOT 

Links>County Maps. Scroll to Wakulla and download the Waku-c.pdf to the rwmap folder within your 

workset. 

 

Note All Florida County Maps can be found in MicroStation DGN format and PDF format at: 
http://www.fdot.gov/geospatial/countymap.shtm 

http://www.fdot.gov/geospatial/countymap.shtm
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 Navigate to the Home tab and select References from the Attach Tools button. 

   

a. Attach the waku-c.pdf as a reference, setting the Detail Scale: Full Size 1 = 1 

 

b. Fit view and the zoom into the project location, which is the intersection of SR 61 and US 98. 

 Navigate to the Drawing Production tab and select the Place Named Boundary tool. 
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c. Fill out the Place Named Boundary dialog as shown below 

 

d. Place the named boundary in the drawing with the project location in the middle. 
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e. Once the named boundary is placed, the Create Drawing dialog will display. Fill this out as shown 

below, making sure the Drawing Model annotation scale matches the Detail Scale set on the Place 

Named Boundary dialog. Once filled out, click OK to create the Key Sheet. 

 

Note There is a Bentley display bug with the map showing up. You may need to zoom in and then out to get the 
map to show. 

 On the Drawing Production tab, use the Edit Text tool to enter the information GOVERNING STANDARD 

PLANS as 2019-20. 
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f. Use the Edit Text tool to enter the information GOVERNING STANDARD SPECIFICATIONS as 

July 2019. 

 

g. Use the Edit Text tool to enter the Construction Contract No. as T-8888. 

 

h. Use the Edit Text tool to enter the Fiscal Year Value as 19. 

 

i. Use the Edit Text tool to enter the FDOT Project Manager. 

 

j. Use the Edit Text tool to fill out the ROADWAY PLANS ENGINEER OF RECORD information. 

   

k. Finally, use the Edit Text tool to enter the Section Number and STATE ROAD NO., as shown below. 
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Exercise 4.2 Place and Edit the Components of Contract Plans Set List 

The Components of Contract Plans Set is a list of all the components included in the plan set. This exercise 

demonstrates how to add this list to the Key Sheet. 

 Once the Key Sheet has been created, right-click and hold to bring up the context menu. From the context 

menu, select Component List. 

  

 The MicroStation Place Active Cell command launches with KNComponentsList set as the Active Cell. 

  

 Data Point at the upper left corner of the Key Sheet border to place the cell. 

 The text appears under the COMPONENTS OF CONTRACT PLANS SET on the Key Sheet. 

 To edit the list of components, double-click on the text. 

 Edit the list in the Text Editor dialog. This project should include plans for the following components: 

➢ ROADWAY PLANS 

➢ SIGNING AND PAVEMENT MARKING PLANS 

➢ SIGNALIZATION PLANS 

 Data point in MicroStation when finished editing the text. 
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Exercise 4.3 Create and Place the Key Sheet Index 

 On the FDOT Tab, select LDM from the Actions group. 

 

 On the Linked Data Manager dialog, select the Create new link button. 

 

 From the Link Information dialog, select Create New from Template. On the Select FDOT Template dialog 

select the Sheet Index - Roadway from the Text Notes category. Click OK and save the KSIndexRoadway.txt 

file in your roadway folder. 
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a. Once saved and back on the Link Information dialog, click OK to place the Index. 

b. Place the Index so that it lines up with the SHEET NO. and SHEET DESCRIPTION headers. 

 

c. Once this is placed in the file, the Index will be modified within the actual text file and not in the 

ORD dgn file. To get to the Index text file, from within Linked Data Manager, right-click on the 

Link and select Open Source. 
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Exercise 4.4 Place the Range and Township Map Label 

This exercise describes how to place township and range labels on a key sheet. This is a requirement for the Key 

Sheet.  

Note The Range and Township labels should be known from the Scope of Work. This information can also 
be found within the county map pdf file.  

 With the Element Selection tool active, right-click and hold to bring up the Context Menu. On the Context 

Menu, select Range Map Label.  

  

 The MicroStation Place Active Cell command launches with KMLabelRange set as the Active Cell. 

  

 Data point to place the Range Map Label at the 

correct locations around the map. Place as many 

labels as needed. Reset when finished placing 

labels. 

 Select the Edit Text tool  to edit the labels.  

See the image to the left for the correct Range 

Values and Locations. 

 

 With the Element Selection tool active, right-

click and hold to bring up the Context Menu. On 

the Context Menu, select Township Map Label. 
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 The MicroStation Place Active Cell command launches with KMLabelTnshp set as the Active Cell. 

  

 Data point to place the Township Map Label at the correct locations around the map. Reset when finished 

placing labels.  

 Select the Edit Text tool  to edit the labels.  See the image below for the correct Township Values and 

Locations. 
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Exercise 4.5 Place the Project Location Labels 

This exercise will demonstrate how to add the Begin and End Project Note. 

 Select the Place Note tool, from the Notes Group on the Drawing Production tab. On the Place Note dialog, 

set the Dimension Style to _FDOT_KeySheet_BeginProject. Fill the rest out as shown below. 

 

a. Fill out the Text Editor dialog as shown below. 

 

b. Position the terminator in the desired location 

c. Data point to place the terminator 

d. Position the note in the desired location 

e. Data point to place the note 

 Repeat the same process, using the _FDOT_KeySheet_EndProject Dimension Style, to place the End Project 

Note.  

o END PROJECT 

o STA. 726+45.00 

o MP 9.824 
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 There is another Project Location label that is required for the Key Sheet that points to the Florida map. From 

the Drawing Production Tab, select Place Note. 

 Set the Place Note Parameters as shown below, with the Dimension Style set to 

_FDOT_Key_Sheet_Locate: 

 

 Type PROJECT LOCATION into the Text Editor, select the general project location on the Florida 

map, position the label, and data point again to place it.  The label should display as shown below. 
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Exercise 4.6 Place the Contract Revision Note (Optional) 

The Contract Plans Revision Note is only placed into the file to document which Component and which Sheets 

have been revised throughout the project. If there are no revisions this is not required. 

 With the Element Selection tool active, right-click and hold to bring up the Context Menu. On the Context 

Menu, select Contract Plans Revision Note. The MicroStation  

 

 Place Active Cell command launches with KNContractRev set as the Active Cell. 

 

 Data point to the lower left corner of the Key Sheet border. The Note should display as shown. 
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 Select the Edit Text  tool to enter the Financial Project ID, 220495-5-52-01 as well as the Revision 

Number, the Component Set, the Revised Page Numbers, and Date of Revision. See below. 

 

 Go to the MicroStation View options and turn Off Data Fields.  

 

 Fit View in MicroStation. 

 Select File > Save Setting. 
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Exercise 4.7 Index the Key Sheet 

 Continuing in the KEYSRD01.dgn file, go to the Home Tab, select the Explorer tool from the Primary 

Group 

 

 Select the Sheet Index and then click on the Open Sheet Index for Edit button. 

 

 With the Sheet Index open for editing, expand out the Index to view the folders for each discipline. 

  

 From the Home Tab, select the Models tool from the Primary Group  
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 With the Models dialog open, drag and drop the SR61 [Sheet] model onto the Roadway folder within the 

Sheet Index. 
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PLAN ONLY SHEETS 

Exercise 4.8 Create the Plan Sheets 

 Use the FDOTConnect for OpenRoads Designer icon to open:  

 C:\Worksets\FDOT\FLUG_2019\PLANRD01.dgn file 

 Select Drawing Production > Annotations > Element Annotation > Annotate Element. Left click on the 

CL_SR61 alignment to select it and then right click to accept and annotate the alignment. 

 From the Drawing Production tab, select the Place Named Boundary tool. 

 Drawing Production > Named Boundaries > Named Boundary > Place Named Boundary 

 

a. Select the Civil Plan mode. 

b. Set Drawing Seed to Plan Only 

c. In the 2D view, select the CL_SR61 alignment along which the plan named boundaries will be 

created. 

d. Fill out the dialog, as shown 

e. Follow the prompts in the lower left corner left click to define the named boundaries. Multiple left 

clicks may be required. 

f. Two or three clicks are required to (1) accept the Start Location, (2) accept the Stop Location, and 

(3) create the Named Boundaries. However, if the Start or Stop Location are selected graphically 

one or more of these clicks has already been completed. 

g. On the Create Drawing dialog, click OK to create the sheets. 
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PLAN AND PROFILE SHEETS 

Part 3, Chapter 312 of the FDOT Design Manual (FDM) outlines Florida Department of Transportation (FDOT) 

Roadway Plan and Roadway Plan-Profile Sheets. The Roadway plan sheets show the project’s complete 

horizontal alignment. The plan-profile sheets show the project’s complete horizontal and vertical alignment. 

Various Roadway elements such as pavement width, medians, paved shoulders, curbs, drainage elements, tapers, 

turn provisions, and intersecting roadways, are also shown on these sheets. 

Exercise 4.9 Creating Plan and Profile Sheets 

 Use the FDOTConnect for OpenRoads Designer icon to open:  

C:\Worksets\FDOT\FLUG_2019\PLPRRD01.dgn file 

 Select Drawing Production > Annotations > Element Annotation > Annotate Element. Left click on the 

CL_SR61 alignment to select it and then right click to accept and annotate the alignment. 

 Create Named Boundaries for the plan portion of the sheets. 

 

a. Select Drawing Production > Named Boundaries > Named Boundary > Place Named Boundary. 

b. Select the Civil Plan mode. 

c. Set Drawing Seed to Plan over Profile - Top 

d. In the 2D view, select the CL_SR61 alignment along which the plan named boundaries will be 

created. 

e. Fill out the dialog, as shown, making sure that Create Drawing is unchecked. 

f. Follow the prompts in the lower left corner left click to define the named boundaries. Multiple left 

clicks may be required. A total of two clicks are required to (1) accept the Start Location, (2) accept 

the Stop Location, and (3) create the Named Boundaries. However, if the Start or Stop Location are 

selected graphically one or more of these clicks has already been completed. 
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 Create Named Boundaries for the profile portion of the sheets. 

 

a. Open a profile view for the CL_SR61 alignment. This can be done using the right click View Control 

context menus. 

b. Select Drawing Production > Named Boundaries > Named Boundary > Place Named Boundary 

c. Select the Civil Profile mode. 

d. Set Drawing Seed to Plan over Profile - Bottom 

e. In the profile view, select the profile along which the named boundaries will be created. 

f. Fill out the dialog, as shown below, this time making sure that Create Drawing is enabled. 

g. Follow the prompts in the lower left corner left click to define the named boundaries. Multiple left 

clicks may be required 

h. On the Create Drawing dialog, click OK to create the sheets. 
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CROSS SECTION SHEETS 

Exercise 4.10 Creating Cross Section Sheets 

 Use the FDOTConnect for OpenRoads Designer icon to open:  

C:\Worksets\FDOT\FLUG_2019\RDXSRD01.dgn file 

 Create Named Boundaries which define the location and extent of each cross section. 

 Both the 2D and the 3D models must be open in a view to create cross sections. 

a. Select Drawing Production > Named Boundaries > Named Boundary > Place Named Boundary. 

b. Select the Civil Cross Section mode. 

c. Set Drawing Seed to CrossSection20Scale 

d. In the 2D view, select the CL_SR61 alignment along which the cross section named boundaries will 

be created. 

e. Set the Start Location to 700+00 and the Stop Location to 715+00. the dialog should be filled out 

as shown below. The settings from the Left Offset down are set based on the applied Drawing Seed. 

 

f. Follow the prompts in the lower left corner left click to define the named 

g. boundaries. Multiple left clicks are probably required. Once the named boundaries are created they 

appear in the 3D view. 

h. Click OK on the Create Drawing dialog to create the sheets. 
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PROJECT NOTES SHEET 

The General Notes sheet is required for each project. See Exhibit 311-1 in Part 3 of the FDOT Design Manual 

(FDM) for a list of General Notes that are required.  

Exercise 4.11 Creating the Project Notes Sheet 

 On the OpenRoads Modeling Workflow, select Create File, from the FDOT Tab 

  

 The Create File (v 2.0) dialog displays. On the Create File dialog set the Discipline to Roadway and File 

Group to Roadway Files. From the File Type list, select GNNTRD. On the Output File section of the dialog, 

be sure to set the County to Wakulla. Once everything is set up to match the image below, click Create – 

Open File to create and open the Project Notes file. Click Close to close the Create File (v 2.0) dialog. 
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 From the FDOT Tab, select Linked Data Manager from the Actions group. 

  

 The FDOT Linked Data Manager dialog displays. Select the Create New Link icon. 

 

a. The Link Information dialog displays. Click on the Create New from Template button. 
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b. The Select FDOT Template dialog displays.  Set the drop down to Word Documents and select 

the Project Notes Template. Click OK.   

  

c. From the Save File dialog browse to the C:\Worksets\FDOT\22049555201_CE\roadway folder, 

accept the default filename and Save the file. 

d. From the Link Information dialog, toggle Off the Page Boundary check box and click OK. 

 

e. With the Project Notes attached to cursor snap to the top, left corner of the Plan Sheet and data point 

to place the link. The Link is created and listed in the Linked Data Manager dialog. 
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2. To edit the Project Notes:  Go to the Linked Data Manager dialog, right-click on the link and 

select Open Source. 

Note DO NOT edit the text for the Project Notes in the MicroStation file. Always edit the word document or the 
link will be broken. 

  

a. The Word Document opens the .docx file. Add the utility owners below, Save the file and close it. 

UTILITY AGENCY/OWNERS:      CONTACT TELEPHONE NUMBERS 
TELEPHONE COMPANY A  OWNER A  (850) 222-2222 
GAS COMPANY B   OWNER B  (850) 333-3333 

b. From the Linked Data Manager dialog, select the link again, right-click and select Update Now. 

The Project Notes will be updated in the MicroStation file to reflect the changes made. 

  

3. From MicroStation turn Off Data Fields, Fit View and then select File > Save Settings. 

Note The project notes are also available through Linked Data Manager as a Text Document Template. Follow 
the same steps as shown above, except use the template under the Text Notes option. 
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TYPICAL SECTION SHEETS 

Exercise 4.12 Create the Roadway Typical Section Sheet 

The FDOT Workspace contains a number of Typical Sections that can be used and adjusted to suit the conditions 

of a particular project. For the purposes of this project and class, the New 4 Lane, Divided Urban Typical will be 

used. This Typical Section should be modified based on project specific requirements.  

Note Due to time constraints of this course, the design modification of the Typical Section is assumed.  

 On the OpenRoads Modeling Workflow, select Create File, from the FDOT Tab 

  

 The Create File (v 2.0) dialog displays. On the Create File dialog set the Discipline to Roadway and File 

Group to Roadway Files. From the File Type list, select TYPSRD. On the Output File section of the dialog, 

be sure to set the County to Wakulla. Once everything is set up to match the image below, click Create – 

Open File to create and open the Typical Section Sheet file. Click Close to close the Create File (v 2.0) 
dialog. 
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 From the Drawing Tab, select the Place Active Cell tool and the browse to the TypicalSection.cel library.  

 Find the New4LnDvUrb cell and double click. The MicroStation Place Active Cell command displays with 

New4LnDvUrb set as the Active Cell. 

 

 Set scale of the cell to 1.0. 

 

 Data point to place the cell in the sheet. Reset when finished to exit the Place Cell command. 
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 On the Cell Library dialog, double click on the cell TraffData. The MicroStation Place Active Cell 
command displays with TraffData set as the Active Cell. 

 

 Set scale of the cell to 1.0 

 

 Data point to place the cell in the left bottom corner of the sheet. Reset when finished to get out of the Place 

Cell command. 

 Use the Edit Text tool  to enter the correct Traffic Data information as shown below. 
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 Repeat steps 7 through 10 to place and edit the following cells with the information shown below.  Place 

these cells in the middle of the sheet, under the typical section. 

o Cell Name: NewOBGSPFC125 

OPTIONAL BASE GROUP 6 WITH 

TYPE SP STRUCTURAL COURSE (TRAFFIC B) (2 1/2”) 

AND FRICTION COURSE FC-9.5 (TRAFFIC B) (1”) (PG 76-22) 

o Cell Name: MillPvt 

MILL EXISTING ASPHALT 

PAVEMENT FOR DEPTH (1”) 

o Cell Name: ResrPvtFC95 

FRICTION COURSE FC-9.5 (TRAFFIC B) (1”) (PG 76-22) 

 Go to the MicroStation View options and turn Off the Data Fields option.  Select File > Save Setting. 

 

 Close MicroStation. 
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5 PLAN LABELING DEVELOPMENT 
WORKFLOW 

 

This chapter will introduce the new way of placing notes using the PLACE NOTE or PLACE LABEL tool. This 

tool can be found in the Drawing Production Tab, and the Notes Group of the OpenRoads Modeling Workflow. 

OPENROADS MODELING>DRAWING PRODUCTION>NOTES>Place Note or Place Label. 

We would like to introduce the user to a new workflow terminology using the Ribbon.  If you see a direction like 

this:  OPENROADS MODELING>GEOMETRY>HORIZONTAL>Lines>Line From Element>Simple Line From Element, it means 

we are in the WorkFlow of OpenRoads Modeling which has a Tab named Geometry, and has tools that are 

located in the Horizontal Group. Now that we are in the right workflow, Tab and Group we may need to click 

on a tool that has more than one option. 

The two new ways of labeling your plan sheets are using the Place Note or Place label. First the Place Note is 

just a simple way of placing information 

The Place Label tool will be replacing the Plan View Labeler Tool that was found in Geopak. We want to 

introduce the two different ways of placing notes or labels. The first way is by the Place Note. With this method 

the user would type the note using the text editor dialog and would select a dimension style before placing the 

note.  

PLACE NOTES 
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PLACE LABEL 

 

We have created some Text Favorites to label in the plan, profile and cross sections. 

• The Plan Text Favorite have the prefix of _PL_  
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• The Profile Text Favorite have the prefix _PR_ 

 

• The Cross Section Text Favorites have a prefix _XS_ 

 

EXERCISE OVERVIEW – PLACE LABELS 

5.1 Place Dynamic Labels 

5.2 Place Labels on the Plan 

5.3 Place Labels on the Profile 

5.4 Place Labels on the Cross Section 
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Exercise 5.1 Place Labels on the Plan 

In this exercise, we are going to open the PLANRD_PLAN_LABELING_01.dgn to place dynamic labels.  

We will place a Begin Project, Begin Construction, Station Offset Labels. 

 Click on the FDOTConnect for OpenRoads Designer icon to launch the file,  

PLANRD_PLAN_LABELING_01.dgn.  

 

 Once the file is open make sure you are in the OpenRoads Modeling workflow, then selecting the Drawing 

Tab look for the Primary Group select the Models dialog to switch to the Drawing Model. This is where we 

will start placing our labels. 

OPENROADS MODELING>DRAWING>PRIMARY> Models 
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 Switching to the Drawing Production Tab of the OpenRoads Modeling Workflow we need to find the Notes 

Group then the Place Label button. 

OPENROADS MODELING>DRAWING PRODUCTION>NOTES>Place Label 

 

 Set the Level to a TextLabel before placing any notes or Labels. 

 This will bring the Place Label Dialog, set the Type to Text Favorite, Select Text Favorite from list. Set your 

Dimension Style from list (Set the Dialog as the picture below.) 

 

 

 Once the dialog is set, select the Alignment from which you would like to track to place the label, then select 

where you want the label to be placed. 

 Use the same process to place the Begin Construction, Station Offset 
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Exercise 5.2 Place Labels on the Profile 

In this exercise, we are going to open the PLPRRD_LABELING_01.dgn to place dynamic labels.  

We will place a Begin Profile, Begin Widening, Begin Milling-Resurfacing, End Profile, End 

Widening, End Milling-Resurfacing. 

 Click on the FDOTConnect for OpenROads Designer icon to launch the file PLANRD_LABELING_01.dgn  

 

 Once the file is open make sure you are in the OpenRoads Modeling workflow, then selecting the Drawing 

Tab look for the Primary Group select the Models dialog to switch to the Drawing Model. This is where we 

will start placing our labels. 

OPENROADS MODELING>DRAWING>PRIMARY> Models 
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 Switching to the Drawing Production Tab of the OpenRoads Modeling Workflow we need to find the Notes 

Group then the Place Label button. 

OPENROADS MODELING>DRAWING PRODUCTION>NOTES>Place Label 

 

 Set the Level to a TextLabel before placing any notes or Labels. 

 This will bring the Place Label Dialog, set the Type to Text Favorite, Select Text Favorite from list. Set your 

Dimension Style from list (Set the Dialog as the picture below.) 

 

 Once the dialog is set, select the Profile that you would like to track off of to place the label, then select where 

you want the label to be placed. 

 Use the same process to place the Begin Milling and Resurfacing, Begin Widening. 
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Exercise 5.3 Place Labels on a Cross Section 

In this exercise, we are going to open the RDXSRD_LABELING_01.dgn to place dynamic labels.  

We will place a Elevation, Offset-Elevation. 

 Click on the FDOTConnect for OpenROads Designer icon to launch the file PLANRD_LABELING_01.dgn  

 

 Once the file is open make sure you are in the OpenRoads Modeling workflow, then selecting the Drawing 

Tab look for the Primary Group select the Models dialog to switch to the Drawing Model. This is where we 

will start placing our labels. 

OPENROADS MODELING>DRAWING>PRIMARY> Models 
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 Switching to the Drawing Production Tab of the OpenRoads Modeling Workflow we need to find the Notes 

Group then the Place Label button. 

OPENROADS MODELING>DRAWING PRODUCTION>NOTES>Place Label 

 

 Set the Level to a TextLabel before placing any notes or Labels. 

 This will bring the Place Label Dialog, set the Type to Text Favorite, Select Text Favorite from list. Set your 

Dimension Style from list (Set the Dialog as the picture below.) 

 

 Once the dialog is set, select the Point that you would like to label. 

 Use the same process to place the Offset-Elevation. 
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6 TRAFFIC PLANS WORKFLOW 

ORD SETUP 

OBJECTIVES 

This chapter covers the initial setup required to start using this tutorial. 

In this chapter, the following topics will be covered: 

• FDOT Workspace  

• FDOT Worksets 

• Creating a New Project  

• Create File Process 

OVERVIEW 

If this is your first-time opening FDOT ORD you will need to do some basic setup before you can begin your 

project design, this chapter will cover the basics. 

FDOT WORKSPACE 

When you launch FDOT ORD you are greeted with the following screen. ORD needs a starting point to 

begin, so you will need to point to a WorkSpace and WorkSet. The image below tells you that neither have 

been selected. 
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To set a Workspace select the pulldown to see the list of available workspaces and select FDOT as shown 

below. 

 

Not only can you select a workspace from this dialog, but you can create different WorkSpaces in case you 

are working for multiple DOT’s  

SETTING WORKSET LOCATION 

Now that you have the WorkSpace and all the settings that are inclusive to that particular work space, you 

need to set the WorkSet, which represents your active project folder and drawings. Using the pull down to 

display the list select the FLUG Dataset workset, which is used for this workbook. 

 

If you have worked in this workset before a list of recently opened files are visible and are ready to be opened. 

The Recent files list only applies for the current workset. 
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PROJECT SETUP 

You do not need to do this for this workbook, but this topic is for future reference on starting a new project from 

scratch using the FDOT WorkSpace, with the work space set to FDOT pulldown the Work Set List and select 

Create WorkSet.  

 

The Create WorkSet dialog box opens, which you will fill in the Name, Description, Template, Location, and 

other data. Make sure for template you select 0_WORKSET_TEMPLATE. Select OK when finished. 

It’s important to note that the first file you must open is the _BlankFile.dgn, this will allow you to start the design 

file creation process using the Create File application located on the FDOT Ribbon in ORD. The BlankFile has 

a notification letting you know to not start any design file usage from this file. Using the Create File app applies 

proper symbology to the new design files. 
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CREATE FILE 

This process has already been completed for this manual, but for reference the process to create project design 

files is covered in this section. Located on the FDOT Ribbon on the Actions panel is the Create File application 

 

Once selected the Create File dialog opens as shown. A description of each option is listed below 

 

• Workset - The workset by default should be the current workset where your project is located, this will allow 

the create file to create and place new files in the proper project folder. 

• Discipline - The discipline options are Architectural, Geotech, MechElec, Right of Way, Roadway, & 

Structures. The signing and Pavement marking design files will be in the Roadway Discipline. The discipline 

choice controls what filenames are used. 
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• File Group - The File Group controls what component discipline is displayed upon selection. The S&PM 

plans will use the Signing and Pavement Marking Files File Group. The options are shown below. 

 

• File Type - The File Type displays the Base Filename along with a Description of what the Filename 

contains. 

• Output File - The output file section displays the actual name of the file including the File sequence number 

and Extension. A modifier entry box is also available as an optional entry. A path is displayed showing the 

name and the location of where the app will put the design file. 

• Output Folder - The Output Folder is automatically selected as the location of the file based on FDOT 

Standards. If the box is green that means it has found the project folder structure and the target folder exists. 

If the box is red that means the target folder does not exist within the project folder. There is a Browse button 

available which will allow you to search for the folder 

• Seed File - The seed file is automatically selected based on standards, however the user can browse to a 

different one if required. 

• County & Coordinate System - The County and Coordinate System are linked, if the user changes the 

County the coordinate System will change if the new county is in a different Coordinate System. 

• Create -Open File - The Create – Open File when selected will create and open the file in the background. 

The user can create as many files at once as needed. When desired files are created select close to exit the 

dialog. 
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SIGNING TOOLS 

OBJECTIVE 

This chapter covers the sign applications available in the FDOT ORD Work Space. There are Cell drawing files 

included, containing all sign cells from the M.U.T.C.D. and Standard Highway Sign book. These cells can be 

placed anywhere within the design file. 

In this chapter, the following topics will be covered: 

• FDOT Signs application  

• Guide SIGN 7.0 

OVERVIEW 

At this point, the designer may have an inventory of existing signs for their project. The designer must decide 

which signs need to be removed, relocated, or replaced. This work should be done in the proposed design file, 

DSGNSP01.dgn.  

The FDOT Signs program is another source for placing proposed and existing sign cells. It allows the designer 

to build sign assemblies and place them in the design file. The sign post contains the pay item data required to be 

quantified., the panel contains no pay item data. The ORD version of the FDOT Signs application is very similar 

to the Civil 3D version.   

GuidSIGN, is a sign design program available from Transoft Solutions, and is included in this section and 

briefly explained.  

FDOT SIGNS APPLICATION  

Accessible from the FDOT Ribbon on the Traffic Plans panel, the FDOT Signs Application is designed to assist 

in the placement of standard sign panels and posts in the signing and marking plans. This tool uses a separate xml 

file that contains all pay item data required to quantify correctly. All the signs that are in the Standard Highway 

Sign Book and the Florida Roadway and Traffic Design Standards have been included. The application is a 

palette-based program. 

   

The FDOT Signs App has four tabs: Assembly Creation, Labels, Tools Settings, & User Settings  
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ASSEMBLY CREATION 

  

We will start when the start assembly button is selected. The dialog box shown above right opens. 

➢  Cancels Assembly Creation: When selected it cancels the assembly creation process and 

returns to the default dialog as shown above left. 

➢ Name: User can assign a name or an automatic default name will be used. A 3-digit counter is added 

at the end, this allows same named assemblies to exist in the design file without being over written. 

➢ Justify: Allows the panel(s) to be set either Left, Center, or Right in the assembly.  

➢ Structure: The user can designate the assembly structure as Panel and Post, Post Only, or Panel 

Only.  

➢ Confirm Assembly Settings: This is selected when the assembly parameters are set and the 

designer is ready to move on to the next step. 

ASSEMBLY CREATION - PANEL 

The panel assembly portion of the process is where you pick the panel(s) to add to the assembly and preview 

your work before moving on to the next step. 

➢   Location – When selected a grid box opens 

showing where the panels are in relation to each other 

in the assembly. The user can also change locations 

from here by right clicking on the populated grid box 

for options. The grid box also contains the back side 

of the assembly if it is a double-sided assembly. 

➢   Panel Search – Allows the user to search for a 

panel by name and bypasses the navigation to the 

desired panel.  

➢ Application - This gives the designer the ability to 

select from the list of options including 

Conventional, Expressway, Freeway, Minimum, or 

Oversized. The selections made upstream effect 

what’s available downstream in the selection process 

of other options. 

➢  Panel Class – Panel Class is another way to shrink 

down the panels to choose from, it contains a big list 

of classes; Regulatory (R), Route Markers (M) and 

more, the letters in parenthesis designate the panel 

name. Example being Route Markers (M) = M1-7 

panel name. 
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➢ Panel Name – With the previous selections made the list is culled down to the available panels and 

will populate with the panel name. 

➢ Size – The user can select the Search icon to select the available sizes that go with the panel selected, 

if a size is not preset you can enter in a custom size. An example entry being 24x36 which will equal 

6 S.F. It is the designer’s responsibility to know what size sign to use, do not assume this tool has 

the intelligence built in to determine the correct size to set for the sign panels of the project. 

➢ State – The user has 4 states to choose from; Proposed, Existing to Remain, Remove, and Relocate. 

The All button will force the state chosen to all panels in the assembly. 

➢ Panel Area – This displays the Square Footage of the current panel that is being added to the 

assembly. 

➢ Panel Preview – When a panel is selected it displays a preview of how the panel(s) will look before 

placement. 

➢ Add First Panel – The user must select this button to add it to the assembly, if another panel needs 

to be added the user will repeat the previous steps to add it. 

➢ Total Area – This displays the total Square Footage of all panels that are part of an assembly. 

➢ Confirm Assembly – When all panels have been added to the assembly and the user is ready to 

move on to the post options click on Confirm Assembly.  

ASSEMBLY CREATION - POST 

➢ Post Search – Allows user to search for a specific post which will avoid the pulldown navigation 

to choose the post. 

➢ Installation – The user selects which installation method to use. 

The following are available, Ground Mount, Panel Only, and 

Overhead.  

➢ Mounting – This allows the user to select the type of sign 

mounting, options being Single or Multi-Post, Sign Beacon, 

Delineator, Highlighted Sign, Object Marker, Internally 

Illuminated Sign, Dynamic Message Sign Support Structure, or 

Electronic Display Sign. 

➢ State – There are several states available; Proposed, Existing to 

Remain, Relocate, Remove, and Proposed/Remove.  

➢ Sign Type – The options displayed to choose from is dependent 

on the type of State selected. 

➢ Options – This pull down gives the user ability to pick whether 

the sign is one sided, two sided, or single post or multiple posts. 

The options available are based on the previous selections made. 

➢ Panel Custom Label Fields – This is where to fill in any open 

fields on a sign panel. Example, the Speed Limit sign has one 

field that needs to be filled in. When the Speed Limit sign is 

selected Field 1 becomes active to enter the speed. This will 

change the preview display to show the new speed. If a sign is 

selected with more than one field in it the FDOT Signs tool will 

recognize this and the appropriate number of fields will become 

active. 

➢ Pay Item – This will show a preview of the post cell used and 

the Pay Item information assigned. 

➢ Confirm Post – When selected the assembly is ready for 

placement and the tool moves to the placement process. 
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ASSEMBLY CREATION – PLACEMENT 

 

➢ Rotation Type and Angle – There are two options for Rotation, Relative and Absolute, Relative 

allows the assembly to be rotated parallel to the roadway alignment and the flow of traffic, for this 

reason it is the default. Absolute allows the user to enter in a fixed rotation angle. 

➢ Place on Alignment – This toggle when on will place the assembly along an alignment with a 

Station, if toggled off it will be placed freely with no association to the alignment. 

➢ Place Panel – Starts the process of placing the assembly starting with the panel first. 

➢ Place Post – Starts the process of placing the post to go with the previously placed panel. 

➢ Finish Assembly – Once the assembly is placed this should be selected before moving on to the 

Label options. 

LABELS  

 

LABELS – GENERAL SETTINGS 

➢ Text Style – Controls which font is used for the labels, default is set to FDOT. 

➢ Add Shapes – When toggled on, the Pay Item Number Label has a Rectangle shape and the Sign 

panel name has an Oval shape. 
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LABELS – PANEL  

➢ Display Name – Controls if the Panel name is part of the label or not. 

➢ Display Size – Controls if the Size of the panel is part of the label or not. 

➢ Display State – Controls if the state is labeled, default is proposed. If toggled on the “Existing to 

Remain” or “To Be Relocated” state will be part of the label. 

➢ Level – Provides a level override if needed, the default is TextLabel for Panel labels. 

➢ Place Panel Label – Executes the place panel label command, user picks the panel to label and then 

the location of the label. 

LABELS - POST  

➢ Display Pay Item – Controls if the Post label contains the Pay Item Number. 

➢ Display Station – Controls if the Station location is part of the label or not. 

➢ Display State - Controls if the state is labeled, default is proposed. If toggled on the “Existing to 

Remain” or “To Be Relocated” state will be part of the label. 

➢ Level - Provides a level override if needed, the default is PayItem_dp for Panel labels. 

➢ Place Post Label - Executes the place post label command, user picks the post to label and then the 

location of the label. 

LABELS – SAVE/RECALL LABEL SETTINGS 

➢ Recall or Save – Allows users to save and recall their label settings for future sessions. 

TOOLS & SETTINGS 

 

TOOLS & SETTINGS – CONNECTOR 

➢ Set Level – The default level of the connector line is TextLabel, but can be changed by use of the 

pull-down menu. 

➢ Connect Assembly – The connector line is the leader line between the post and panel and will 

dynamically stay connected if panel or post is moved. If the design file has assemblies that are not 

connected the user can use this command to add them after they are placed. 
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TOOLS & SETTINGS – MODIFICATION 

➢ Issue Cleanup – Allows user to delete unused sign assembly data from drawing file. Each cleanup 

option can be controlled with a check toggle.  

 

➢ Same Assembly – Deletes duplicate named assemblies. 

➢ Same Post – This will delete duplicate sign labels that are in the file. 

➢ Same Sign Label – This will delete duplicate sign labels that are in the file. 

➢ Orphan Label – If an assembly has been deleted and the label somehow remains, this will delete 

the label that is not associated to any assembly. 

➢ Missing Alignment – If an alignment that has Sign Assemblies associated to it is deleted, this will 

delete all signs that are still associated to the deleted alignment. 

➢ Clear Highlight – When the list is populated with scan results of selected criteria, this is used to 

clear the list which will remove the data from the file. 

➢ X – This closes the Cleanup tool. 

➢ Convert Free – Converts already placed assemblies to a free state which has no association to an 

alignment. 

➢ Match Scale – Common scale for a FDOT design file is 1” =40’, but in cases where the scale is 

very different Match Scale will adjust the assembly sizes in the file for better visibility. 

➢ Update Stations – The user can update the station of the assembly if it has been moved or copied. 
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USER SETTINGS 

 

USER SETTINGS – GENERAL 

➢ Highlight Assembly When Selected – Controls when an already placed assembly is selected from 

the assembly pull down list is highlighted or not. 

➢ Show Label Removal Warning – When relabeling an already placed assembly, when toggled on 

a warning will display telling you that you are about to delete and relabel an assembly. 

➢ Add Connector on Placement – When toggled on it will automatically place the connector line as 

the assemblies are placed. 

➢  Show Alignment Warning – When toggled on it will warn the designer if they are about to change 

alignment association.  

➢ Zoom Assembly – When toggled on it will zoom to the selected assembly from the list. 

➢ Zoom View – Controls how far the selected assembly is zoomed in. 

➢ Station Precision – Controls how many decimal places are displayed in the station label, default is 

set to 0 to match standards. 

➢ Tab Alignment – The user can change the side of the dialog box that displays the tabs. The options 

are along the top or along the right side. 
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USER SETTINGS – FILES 

➢ Browse Folder – The browse folder is where 

you save and/or recall sign assemblies. The 

user should change this location to point to 

the sign assembly folder within the ORD 

install which contains already created 

assemblies. 

➢ Custom Guide File – This location is where 

your cells reside in the guide sign file you have created for your project, this location will constantly 

change as you work through a design. It is not important where the default location is pointing. 

➢ Panel Cell Folder – This points to the root folder cell library location that contains all the required 

sign panels that you will use in your project design. 

➢ Post Cell Library – This points to the cell library location that contains all the required post cells 

you will use in the design. 

USER SETTINGS – ADMIN ONLY 

➢ Application Folder - Opens the location of the 

FDOT Signs folder within the ORD Installation 

location  

➢ FDOT.Signs.xml File – Opens the 

FDOT.Signs.xml file for editing. It is recommended 

that that the user not edit this file, however if it is 

necessary use this command to access it. 

➢ Settings Default.xml File – This file should 

already be set; however, the user can change this 

file and then Select the Load Default Settings to load settings into the application. 

➢ Error Log File – When selected this will open the Error Log File to determine what error has 

occurred that can then be passed to the CADD office for the developer to evaluate. 

➢ Load Default Settings – This loads the Settings.Default.xml File discussed above. 

➢ Validate FDOT.Signs.xml – This will validate the cells and cell files that are necessary for the Sign 

Tool to function correctly. It will report what is missing. 

➢ FDOT Sign Assembly Tool Version – Identifies the version of the sign application, this is useful 

when reporting bugs or issues with the program. 

Note When the Sign tool is launched for its initial use a dialog displaying pathing that will need to be changed 
so the sign tool will work properly, Expand the dialog so you can see all options. Select Reset Folders to 
change the pathing that is shown below. This dialog will only display upon first time use.  
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EXERCISE OVERVIEW – SIGNING TOOLS 

6.1  Place Single Post Sign Assembly 

6.2  Save the Sign Assembly 

6.3  Update Sign Post Location 

6.4  Place Multi-Panel Sign Assembly 

6.5  Create and Place a Sign Assembly Using 2 Methods (Part 1)  

6.6  Placing Same Sign Assembly Using a Saved XML File (Part 2) 

6.7  Review the Sign Assembly Inventory in a File 

 

Exercise 6.1 Place Single Post Sign Assembly 

In this exercise, the designer will build, place, and label a simple sign assembly. The Sign tool is designed so the 

user works top to bottom making selections. 

 Open the Dsgnsp01.dgn file and zoom in near Station 702+20. 

 Select the Rotate View   button select the 2 Points command and using the SR61Alignment as the object 

select anywhere near station 701+00 for the first point and anywhere neat station 702+00 for the second 

point.  The drawing should look like below. 

 

 From the FDOT Ribbon, select the FDOT Signs icon to open the application. 
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 From FDOT Signs, select the Create New Assembly  icon.  

 

a. Name enter M1 4, notice the name has added -001 to the end. 

b. Justify to Center. 

c. Structure set Panel and Post 

d. Select Confirm Assembly Settings. 

 Click on the Location icon to change the location of the panel on the grid. 

 Click on Cell F(1,0). This will be the Route Marker Panel location. 

 

 In the Panel Section: 

a. Set the Application to Conventional. 

b. Set Panel Class to Route Markers(M) 

c. For Panel Name Select the M1-4 (3 Digits). 

d. Size is preset with one option, select 

30”x24”. 

e. Set State to Proposed.  

f. For Field 1 type in 319 the panel preview 

shows the text.  

g. Click Add First Panel, 
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 On the Location Grid select the one above the panel already created, F(0,0). 

  

 

 Select another Route Marker, M3-1 which is the NORTH panel. 

 For size select 24”x12” from the available options. 

 Set State to Proposed. 

 Select Add Next Panel, then Confirm Assembly. You should see a preview of the 2-panel assembly. 

 

 Select Confirm Assembly. 

 For the Post Parameters enter the following. 

a. Set the Installation to Ground Mount. 

b. Set Mounting to Single or Multi-Post. 

c. Set State to Proposed. 

d. Set Sign Type to Furnish and Install Ground Mount. 

e. Set Options to 1 Sided.  

f.  Click on Confirm Post to continue to the Placement section. 
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 Select Place Panel to start the panel placement command. 

 The command line asks to select the Alignment, select the SR61 Alignment and select an area in the drawing 

on the south side of the alignment away from the sidewalk to allow room for labels and connector line. Left 

click to place panel. 

 

 Select Place Post, notice how the app remembers the Alignment and is ready to place the post, left click to 

place the Post near Station 702+20. 

 Select Finish Assembly to proceed to placing Labels. The drawing should look like below. 

 

 Select the Labels tab and make sure to match the following settings as shown below. 

 

 Click Place Panel Label, click the NORTH panel, select the label location to the right of the assembly, 

click on the Route Marker panel and place the label below the previous label. 
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 Click Place Post Label, click the post, for label location pick below the previous labels. Your drawing should 

look like below. 

 

Note Label placement is a personal preference. Be consistent with how you place sign labels so the plans look 

professional. Use MicroStation commands to move the Sign Names and Sizes so they are centered under 

the sign panels and are stacked from top to bottom. 

 When the panels are placed you may see the data fields still be visible along with the desired text, to cut off 

the data fields use the view attribute pulldown and toggle off Data Fields  

     

Exercise 6.2  Save the Sign Assembly 

In this exercise, the designer will save the previously placed sign assembly as an xml file, so that it can be recalled, 

placed, and labeled in a future instance. 

 Switch to the User Settings tab on the Sign tool and change the folder used for saving and recalling assemblies 

as shown.  

 Switch back to the Assembly Creation tab and select the Save Icon  

 The save as dialog box opens already in the folder you just set, Name the assembly M1-4_M3-1.xml. 

 Press Ok to save and close the dialog. 

 Save your file before continuing. 
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Exercise 6.3 Update Sign Post Location 

In this exercise, the student will move the post location of an already placed assembly. 

 Continuing in the DSGNSP01.dgn. 

 Zoom to the location of the previously placed assembly. 

 Move the post a few feet in either direction. 

 Notice that when you click to place the post the station value automatically updates along with the connector 

that keeps the attachment between the post and panel. 

 Save drawing before continuing. 

Exercise 6.4  Place Multi-Panel Sign Assembly 

In this exercise, the student will use the same process as in the previous exercise to assemble and place a four-

panel sign assembly. 

 Continuing in Dsgnsp01.dgn, zoom to the vicinity of Station 703+00. This sign will be added on the North 

side. 

 Open the Sign tool, if closed, select Start New Assembly.  

 Name the new assembly M1-4Panel and select Confirm Assembly Settings. 

 In the Panel Section, make selections for Panel 1 of 4 as shown below. 

 

 Select Add Panel. 

 Make the following selections for Panel 2 of 4. 

 

 Select Add Next Panel. 
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 Click on the Location icon and select the location that is marked yellow in the diagram below, notice the 

used locations are green. 

 

 Make the following selections for Panel 3 of 4. 

 

 Select Add Next Panel. 

 Click on the Location icon and select the location that is marked yellow in the diagram below. 

 

 Make the following selections for Panel 4 of 4. 

 

 Select Add Next Panel. 
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 Notice the preview of the assembly and how the Panel Area is at zero, but the Total Area is 13.38sf this is 

the total area of all four panels. 

 

 Select Confirm Assembly. 

 In the Post section make the following selections. 

 

Note Notice the Pay Item information is different from the previous assembly you placed. This is because of the 
additional square footage of the panels. This is automatic and controlled by the signs.xml file, so the user 
will not have to make the selection. The data is placed on the post when placed. 

 Select Confirm Post. 

 Select Place Panel. 

 Make sure Rotation is set to Relative and Place on Alignment is checked. 
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 Select Place Panel and click near the Station 703 as shown below. 

 

 Select Place Post and Select close to Station 703+00 just outside the Sidewalk. 

 Click Finish Assembly, then select the Labels tab. 

 Select Place Panel Label, select one panel at a time and place the label. You don’t need to select the Place 

Panel Label again, due to the command is always active until you change to the post. 

 Select Place Post Label and select below the previously placed labels. The completed assembly is shown 

below. 

 Save drawing before continuing. 
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Exercise 6.5  Create and Place a Sign Assembly Using 2 Methods (Part 1) 

In this exercise, the designer will create and place a warning arrow sign assembly two times using different 

techniques. The designer will first place it like previous steps, then the designer will recall a previously saved 

version of the assembly. 

 Continuing in the DSGNSP01.dgn switch to the FDOT Ribbon and select the 2 Point Twist command. 

 Rotate and zoom to the area as shown below. 

 

 Open FDOT Signs if not already open. Create the following assembly using the steps from earlier exercises. 

  

 Place the panel and post around Station 708+00 and label the panel and post as shown below. 

 Save your file before continuing. 

 

 On the Sign Tool switch to the Assembly Creation tab. 

 Click on the save assembly button . 

 Name the assembly W1-8L & press OK. 
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Exercise 6.6  Place same sign assembly Using a Saved XML File (Part 2) 

In this exercise, the designer will open a saved sign assembly and place in the design file. 

 Continue working in the DSGNSP01.dgn file. 

 Close the Sign tool if open. 

 Re open the sign tool 

 Click on Opens assembly from XML file button in the FDOT Signs app.  

 

 Using the list pulldown select the W1 8L assembly. A preview is shown to verify the selection. 

 

 Select Load. 

 To save you time, the sign tool pre-loads all settings based on how it was saved. If no changes are needed 

select Confirm Assembly and then Confirm Post. 

 Place the Panel & Post. 

 Select Finish Assembly 

 Switch to the Labels tab on the sign tool. 

 Label Panel and Post. 

 Save drawing before continuing. 

Note At the time of this manual revision the 3rd method of placing the same assembly is not completely working 
yet like it does in Civil 3D. The method is copying an already placed assembly and moving it along a curve 
and left clicking to place it, the post will rotate to maintain the relative position to the alignment. You can 
copy an assembly along a tangent portion of roadway and left click anywhere along the tangent to place 
the copy and the post station will update. 
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Exercise 6.7 Review the Sign Assembly Inventory in a File 

In this exercise, the designer will open the sign tool while the dsgnsp01.dgn is open to get familiar with navigating 

around the already placed assemblies in the file. This exercise will show the importance of proper naming 

conventions of assemblies. 

The drawing should contain 4 Sign assemblies if you have followed the previous exercises. 

 

 Continue working in the dsgnsp01.dgn file. 

 Close the Sign tool and Re-open it. 

 Click on the Assembly pulldown list. 

 

 The list contains the 4 placed assemblies, naming is important due to the number of assemblies a project 

could contain. Notice the two W1 8L assemblies in the list. The difference in the name is the 3-digit number, 

this will allow you to have unlimited assemblies of the same name. 

 From the assembly list select the W1 8L-001 sign. 
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 Two things happened, the selected assembly is highlighted in the file and the sign tool dialog has populated 

with the settings of the assembly.  Notice the criteria is grayed out and not editable. 

 

 If desired, you can edit the assembly criteria by pressing the Edit Assembly button  to 

unlock the criteria. 

 Save your drawing. 

Note Editing an already placed assembly means you can change any setting in the controls or even change the 
panel or add additional panels. Once the changes have been made you will need to confirm the assembly 
and place the panel and post like you did initially along with re-labeling. 

When re-labeling an assembly a warning message alerts you that you are about to delete an existing label 
and replace it with the new label, go ahead and select ok to replace the label. 
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PAVEMENT MARKING TOOLS 

OBJECTIVE 

The objective of this chapter is to create Proposed Pavement Marking Features using the Pavement Marking tool 
located on the FDOT Ribbon in ORD. 

OVERVIEW 

This chapter demonstrates several applications that help to create a Pavement Marking set of plans:  

Pavement Marking tool - An application within the FDOT Workspace that is used to draw Pavement Marking 

in accordance with the FDOT (CADD) standards.  

Refer to the Plans Preparation Manual, Volume 2, Chapter 23 for more detail on developing the Signing and 

Marking plans. Refer to the Design Standards indexes for details. 

PAVEMENT MARKING TOOL 

 

Many of the Traffic Plan items are simple 2d line styles drawn and have pay item information already placed for 

future Quantity Reports.  To draw Pavement Markings with the tool, select the Pavement Marking icon on the 

Traffic Plans panel on the FDOT Ribbon. 

 

There are three modes in the Pavement Marking tool to aid in the design and layout of Patterns: Striping, 

Separator, & Merge/Diverge Chevrons.  
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STRIPING 

 

The Pavement Marking tool places all solid or skip Pavement Markings. The striping tool can use an 

Alignment, or Line for pattern placement.  

✓ Stripe Pattern 

 

There is a single pattern which by default is active draws a single stripe, if you toggle on Enable Outside the 

dialog changes to display the options shown below. The verbiage changes to denote an Inside and Outside 

Pattern. That can be placed. The designer can enter in the distance between stripe patterns, along with the 

offset distance from the source element, the distance is measured from the center as a default; however, the 

justification can be changed.  

There is a history list that the designer can quickly change patterns, the history list contains the last 10 patterns 

the designer has selected, to access the history list click on the pulldown button in the pattern name. 

Enable Outside (Double Stripe) allows for four possible configurations set up with a combination of 

Solid/Solid, Skip/Skip, Solid/Skip and Skip/Solid markings. The figure shows the Double Stripe Pattern set 

up to draw a 6” solid yellow line on the Inside and a 6” 10/30 Skip line on the Outside with a 0.33’ or 4” 

Distance Between Stripes. 
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This is a typical set up for a two-lane roadway with a passing zone on one side, as depicted in the figure 

below. 

 

➢ Justification – Justification is used to measure the distance from inside and outside patterns, Center 

splits the distance between patterns and adds on both sides, picking either Left or Right designates 

the side the pattern is placed. 

➢ Distance Between Stripes – It is the space between two striping lines. This distance is expressed in 

terms of master units. There will be times when the designer will need to use a larger distance 

between lines than what the design standards call for. Example, if the signing and marking plans are 

at 100 scale a 4” separation between two 6” lines is not enough, the two lines appear like one thick 

line. 

➢ Offset – The distance between the source or reference element and the beginning of the striping 

pattern(s). 

➢ Draw Perpendicular – Allows the user to draw patterns perpendicular to a source line, an example 

of use is a Stop Bar or Cross Walk Striping. 

➢ Enable Outside – Like discussed above, if toggled on you can add an additional pattern to place 

alongside the inside pattern. 

➢ Use Outside PayItem – This toggle identifies if the pay item data if different between the two 

patterns. 

➢ Use Inside Stripe for Outside – If toggled along with Enable Outside toggled it copies the inside 

pattern and uses the same for the outside pattern. 

➢ Use Element Points- Must be toggled on to be able to select line work. 

➢ Use Buffer – If toggled this allows user to select the begin and end point along the reference element 

selected to place patterns. 

The figure below shows how the buffer function works. The reference line used which is 300’ long 

along with the new line created 33’ to the right of the beginning point. The reference line is, a 

reference, it does not have to control the length of the new striping pattern created. 

 

✓ Element Data 

 

➢ Element – Lists the name of the reference pattern. 

➢ Start Point – This lists the Coordinates or Station value of the Reference Pattern at the Starting 

Point. 

➢ End Point – This lists the Coordinates or Station value of the Reference Pattern at the Ending Point. 
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SEPARATION MODE 

Another Mode in the Pavement Marking tool is the Separation Mode. This mode allows you to draw stripes 

at an angle between elements such as a center turn lane where it approaches a left turn condition. 

 

   

✓ Separation Pattern 

➢ Item – Select this button to open the Pay Item Database to select a striping pattern. The list to the 

right contains a pulldown that lists the history of previously placed patterns. 

➢ Distance Between Stripes - Allows the user to input the distance between stripes. 

➢ Angle – Allows the user to enter a known angle or to select the pick box to pick two points in the 

drawing to designate the angle used. 

➢ Angle Type – Allows the user to select either a fixed or variable angle for the stripes. 

✓ Control Points 

➢ Begin Striping Point – List the coordinates of the beginning striping point. 

➢ End Striping Point – List the coordinates of the end striping point. 

➢ Draw Stripes – Places the stripes based on the criteria selected. 
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CHEVRON DIVERGE/MERGE 

 

  

The Chevron Diverge/Merge Mode is used for traffic channelization at a gore when traffic flows in the same 

direction as seen in the figure below. Refer to Design Standards for specific design criteria. 

✓ Diverge Pattern 

➢ Item – Select this button to open the Pay Item Database to select a striping pattern. The list to the 

right contains a pulldown that lists the history of previously placed patterns. 

➢ Distance Between Chevrons – Allows the user to input the distance between stripes. 

➢ Chevron Type – Allows the user to select the Chevron type, which determines the direction of the 

pattern. The choices are Diverge and Merge. 

✓ Control Points 

➢ Diverge/Merge Point – List the coordinates of the narrow end of gore. 

➢ Break Line/Gore Point – List the coordinates of the wide end of gore. 

➢ Draw Chevrons – Places the stripes based on the criteria selected. 

 

EXERCISE OVERVIEW – PAVEMENT MARKING TOOLS 

6.8  Draw Striping Patterns 

6.9  Place a 24” Stop Bar 

6.10  Place Two Different Patterns 

6.11  Place and Edit a Crosswalk 
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Exercise 6.8 Draw Striping Patterns 

In this exercise, the user will place a 6” Solid White pattern representing the edge of pavement along the Curb & 

Gutter of the roadway, which is part of one side of a Bike Lane. The user will also add the other side to complete 

the Bike Lane designation. 

 Open or continue working in DSGNSP01.dgn. 

 Twist view and zoom to the area shown below. 

 

 On the FDOT Ribbon select the Pavement Marking Tool . 

 Select the Item button to open the Pay Item Database Window. 

 

 Select Pay Item 0710 11101 which is a 6” Solid White pattern. 

 Select OK. 

 For offset enter .33 which equals 4”. 
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 Make sure Use Element Points is toggled. Make sure selections equals image below. 

  

 Select Draw Stripes and select the Edge of Pavement and left click to the outside. 

 Click Draw Stripes and select the EOP along the arc and left click to the outside.  Your drawing should look 

like below. 

  

 If you select the new pattern and look at the properties, you will see the pay item information as shown in 

the image below. 
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 Select the View Attributes button and turn on constructions to see the construction linework in the 

drawing (or press F7). 

 

 Using the same pattern and criteria as before select Draw Stripes. 

 Near the Traffic Median is a green line representing the EOP, select the line and left click below the line for 

placement. 

 The drawing should look like image below, save your file before continuing. 
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Exercise 6.9  Place a 24” Stop Bar 

In this exercise, the user will place a 24” stop bar at the intersection using a construction line as a reference. Make 

sure Construction Lines are turned on and zoom to the intersection around Station 701+00. 

 Continue working in the DSGNSP01.dgn drawing. 

 Open the Pavement Marking tool. 

 Select the Item button and browse to the following and select it. 

 

 For Offset enter 0. Match criteria as shown below. 

 

 Select Draw Stripes and pick the Construction Line representing the Stop Bar and Left Click anywhere on 

the screen. 

 Drawing should look like image below. 

 Save your file before Continuing. 
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Exercise 6.10 Place Two Different Patterns 

In this exercise, the user will place two patterns, one representing the Bike Lane and the other a 10/30 Skip pattern 

for a lane line. Zoom to the area shown below. 

 

 Continuing in the DSGNSP01.dgn file. 

 Open the Pavement Marking tool if not open. 

 Browse to the patterns for inside and outside as shown below. 

 Toggle on Enable Outside. 

 Match all criteria as shown. 

 

 Select Draw Stripes and pick the EOP pattern that was placed in an earlier exercise. 

 Left Click in the Roadway side to place patterns. 

 Save your drawing before continuing. Your file should look like below. 

 

Note If you are placing two of the same patterns you can toggle Use Outside Stripe for Outside to copy the 
pattern to the Outside List without having to browse the database. 
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Exercise 6.11 Place and Edit a Crosswalk 

In this exercise, the user will place two crosswalk patterns at the intersection using construction lines as a 

reference. Zoom to the area near the intersection. 

 Continuing in the DSGNSP01.dgn file. 

 Open Pavement Marking tool if not already open. 

 Select the inside button and browse to the 0710 11123 Pay item, which is a 12” solid white pattern. 

 For Justification select Inside. 

 Distance between stripes should be 12. 

 Toggle on Enable Outside. 

 Toggle on Use Inside Stripe for Outside, this copies the inside pattern and populates the Outside pattern 

with same. 

 

 Select Draw Stripes and pick the yellow construction line representing the left side of the crosswalk. 

 Left Click anywhere on the screen. The drawing should look like below.  
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 Now we have a little clean up to do Trimming and extending on both sides of the crosswalk pattern. First 

let’s focus on the pedestrian median at the top of the intersection. Switch to the Drawing Ribbon and select 

Trim Multiple. 

   

 Select the construction line representing EOP and pick the two crosswalk lines. 

 

 Next pan to the HC Ramp on the other side. You will need to trim one side and extend the other side to the 

EOP that you placed earlier. 

  

 Using the Trim Multiple command trim one side of the crosswalk. 

 Select the Trim to Element command and extend the left side to the EOP. Drawing should look like image 

above . 

 Save and Exit out of ORD. 
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Exercise 6.12 Add Patterns Inside Cross Walk 

In this exercise the user will use the Separation Mode in the Pavement Marking tool to place cross walk bars 

inside the previously placed cross walk.  

 Continuing in the DSGNSP01.dgn file. 

 Open Pavement Marking tool if not already open 

 Switch to the Separation Mode.  

 

 Select the Item button and browse to Pay Item 0710 11123 (12” Solid White for Crosswalk) 

 Make Selections as shown below. 

 

 Select Draw Stripes and select each side of the crosswalk, Left Click near the bottom to start the drawing 

process. 

 Drag your cursor along the inside from bottom to top (Notice the preview of Patterns). 

    

 Save the file before continuing. 
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PLACE CELL GROUP 

OBJECTIVE 

The objective of this chapter is to provide an overview of and place Cells using Place Cell Group. 

OVERVIEW 

This chapter demonstrates an application that helps to create a Pavement Marking set of plans. An Overview of 

the dialog and its behavior is below. 

Place Cell Group- An application within the FDOT WorkSpace that is used to place 

cells along an element, such as painted messages, rpm’s, Light Poles, and others. The 

application is located in the Traffic Plans panel on the FDOT Ribbon. 

   

CELL GROUP 

Save Pattern/Load Pattern – This function allows the user to save a one, two, or three pattern cell(s), this 

is mainly used for painted pavement messages. The saved pattern contains the pay item data that it was 

created with, when recalled the user can place the pattern without having to browse through the database. 

Cell Selection with Preview – The default active cell is the center, the top and bottom contain toggle buttons 

to make them active also. The red button allows the user to browse the database for the desired pattern. A 

preview window is supplied showing the selected cell. The user must enter in an offset distance from the 

selected element. When the top and bottom cells are active there is an additional control that becomes active, 

the Upstream and Downstream spacing, which controls the distance (measured from center to center of cells) 

between the pavement messages.  
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LOCATION 

Element Used for Cell Placement – This provides information on the source element used for cell 

placement. 

Cell Placement Range – This provides information on the source element such as station values if element 

is an alignment. If it is not an alignment the information is the begin and end coordinates. The buffer controls 

allow the user to place cells at any starting or end point along the source element. 

Spacing and Angle – The user can control whether the cells can be placed once or incrementally along the 

source element. The angle control allows options of Relative, Absolute, and Perpendicular. If you change the 

spacing to increment the data box becomes active allowing the user to enter a spacing distance for the cells, 

mostly used for RPM’s. 

Draw Pattern – This starts the placement process, which will ask the user for a source element to place off 

of. When placing there is a preview of how the placement will look, if it isn’t right the user can change 

parameters until the preview looks correct. Left click when you are ready to actually place the cells. 

 

Exercise 6.13  Place Painted Pavement Message 

In this exercise the user will place a Bike Symbol in the Bike Lane 

1. Continuing in the DSGNSP01.dgn file. 

2. Open Place Cell Group if not already open 

3. Select the Red Browse button on the middle cell section. 

4. Browse to Pay Item 0711 14160 (Bike Symbol) as shown below. 

 

5. Change the Offset to 2. 

6. For Spacing select Once and for Angle select Absolute and enter value of 180. 
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7. Select Draw Pattern and select either pattern representing the bike lane as shown below. 

 

8. The symbol appears at your cursor and you can drag it along the bike lane to desired location and left 

click for placement. 
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Exercise 6.14  Place RPMs 

In this exercise the user will place a White/Red rpm along a 10/30 skip pattern. 

1. Continuing in the DSGNSP01.dgn file. 

2. Open Place Cell Group if not already open 

3. Select the Red browse button and browse to pay item 0706 3 W/R rpm. You may need to collapse all to 

find the rpm easier. 

 

4. Enter 0 for the offset distance. 

5. Spacing should be Increment and 40 for the distance between each. 

6. Angle should be Relative. 

7. For Cell Placement Range enter 25 in the Begin Buffer box, this will start the placement starting 25’ 

from the beginning of the pattern. 

8. Select Draw Pattern and select the 10/30 skip we placed earlier, notice the preview of the rpm’s. 

9. Left Click for final placement. 

Drawing should look like image below. 
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LIGHTING PLANS 

OBJECTIVE 

The objective of this chapter is to provide an overview of applications that exist to aid you in creating Lighting 

Plans. 

OVERVIEW 

This chapter demonstrates several applications that help to create a Lighting Plan:  

• Place Cell Group- An application within the FDOT WorkSpace that is used to place cells, such as light 

poles. 

• Draw Conduit – an application to draw conduit for lighting and signal plans that contain the appropriate pay 

item data. 

Exercise 6.15  Placing Light Poles 

In this exercise the user will place Light Poles using the Place Cell Group application. If you need an overview 

of Place Cell Group refer to the previous chapter. 

1. Continuing in the DSGNSP01.dgn file. 

2. Open Place Cell Group if not already open 

3. Select the Red Browse button and browse to pay item 0715 4 13. 
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4. Make the selections as shown below. 

 

5. Select Draw Pattern and select the Alignment, notice the preview of the proposed placement. You can 

adjust the criteria and the preview will update. Left Click on the Bike Lane side of the Alignment. 

6. Your drawing should look like below. 
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Exercise 6.16 Draw Conduit Tool 

In this exercise the user will draw conduit between light poles. Located in the Traffic Plans panel is the Draw 

Conduit tool. The tool draws different types of conduit complete with the correct symbology including pay item 

numbers. 

1. Continuing in the DSGNSP01.dgn file. 

2. Open Draw Conduit 

3. The dialog box is very simple and has two functions, select conduit and draw conduit. 

 

4. Using the pulldown, select the 0630 2 11 Conduit in the list. 

5. Select Draw Conduit 

6. Draw freehand to the points as shown below, left clicking at each point. 

 

7. If you select the conduit and look at the properties, you will see the following pay item information 
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7 GEOTECH, UTILITIES AND 
DRAINAGE MODELING WORKFLOW 

GEOTECHNICAL (GINT) 

OBJECTIVES 

load gINT data in 2d models (mapping workflow for drilling plan creation and preliminary studies) as well as in 

3d for subsurface interpretation and BIM workflows. 

• Become familiar with the Geotechnical workflow 

• Learn the gINT interface 

• Import gINT data from a dataBase 

EXERCISE OVERVIEW – GEOTECHNICAL (GINT) 

7.1 Create and Setup the ABORRDXX.dgn for the Import of a gINT Database 

7.2 Setup the Borehole Tab 

7.3 Create and Setup the Lithology Tab 

 

Exercise 7.1 Create and Setup the ABORRDXX.dgn for the Import of a gINT Database 

 

 Navigate to FDOT Ribbon Tab of the OpenRoads Modeling WorkFlow looking for the Actions Group click 

on the Create File tool. 

OPENROADS MODELING>FDOT>ACTIONS>Create File 

 Create a ABORRDXX.dgn file with the dialog as shown below. Note your numbering may be different 

depending on how many files have been created. 



Chapter 7 GEOTECH, UTILITIES AND DRAINAGE MODELING WORKFLOW __________________________ Geotechnical (gINT) 

7-2 ©2020 FDOT  FDOTCONNECT for ORD Workflows  

 Be sure you set and check the county to set the correct coordinate system. Once all settings have been verified 

click the Create-Open File. 

 

 Once the ABORRD01.dgn file displays, click Close to close the Create File tool. 

 Using the function key (F9) to open your Reference dialog, attach the ALGNRD01.dgn from the WorkSet. 

Also attached the SURVRD01.dgn from the current project and give a logical name of GDTM to the 

SURVRD01.dgn file 

 Using Level Filters from the Level Display dialog click the filter for GDTM. The Level Display dialog 

may be opened using the function key (F10). 
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Note If the SURVRD file exists, the SURVRD01 -GTMRD logical can be used 

 Once levels are set in the SURVRD file to display the existing ground, set the Terrain Active by selecting 

the boundary to bring up the Context Menu, then select the second icon in the menu. 

  

Note Setting the Terrain to Active will create a new Model that is 3D we will use this Model to view our Profiles. 
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Exercise 7.2 Setup the Borehole Tab. 

 Switch the OpenRoads Modeling Workflow to the Geotechnical Workflow to make the gINT tools available. 

 

 From the ribbon tab select the gINT Projects tab, then from the Connectivity Group select the Database 

Connectivity button. 

GEOTECHNICAL>gINT PROJECTS>CONNECTIVITY>Database Connectivity 

 

o PROJECT tab sets the type of database file to be used.  

o BOREHOLE tab defines the table name and different columns for the points. 

o  Plus icon allows the user to create a new Tab. (Used later to create a Lithology tab.) 

 Select the Project tab from the Database Connectivity and Mapping dialog and change Database Type 

from the default, Microsoft SQL Server.NET Provider, to Microsoft Excel. 

 Click on the Folder icon under Source to locate the excel spreadsheet, SR61 Example format for gINT civil 

tools, located in the Geotech folder of the workset.  
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 Next select a name for the Borehole ID. This will be the PointID column from the spreadsheet. 

 

 Navigate to the Borehole tab to set the properties to display boreholes in the 2D view (Default model).  The 

Location drop down should fill from setting the Project tab. 

 

 The first step is to select a cell to represent the Borehole. From the Geotech cell library select the CSH cell 

and set a Width to 0.10. 

 Next from the Level Creation dropdown, set to Property. From the Level Property dropdown, set the table 

to POINT and column to Level. 
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Exercise 7.3 Create and Setup the Lithology Tab 

 Click on the blue Plus to add a tab to the Database Connectivity and Mapping dialog and name it 

Lithology.  Accept the default Type of Depth- Bottom. 

 

 Set the new LITHOLOGY tab as the screen shot below. 

 

 Click the OK on the Database Connectivity and Mapping dialog. 
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 To set ABORRD01.dgn up with a Default View and a 3D View select the Function key (F2)   <OR> 

 use the right-click and function with the mouse. 

 Select View to make it your active view. Select the Query All button to display the information for the 

Boreholes. Repeat this step for the 3D View. 
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UTILITIES 

OBJECTIVES 

Exercise 7.4 Drainage Modeling 

SUBSURFACE UTILITY DESIGN & ANALYSIS (SUDA) 

Exercise 7.5  
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8 QUANTITIES WORKFLOW 

QUANTITY TOOLS FOR FDOT CONNECT 

OBJECTIVES 

This section will discuss the tools that are currently in development to extract quantity information from the 

design model in the Open Roads Designer FDOT Connect workspace. 

In this chapter, the following topics will be covered: 

• Item Types and Features 

• Asset Manager 

• Linked Data Manager 

• MicroStation Reports 

OVERVIEW 

Quantity tools are still in development.  This lesson will cover the processes that are currently expected to be part 

of the Quantities Workflow.  All methodologies are subject to change. 

ITEM TYPES 

WHAT ARE ITEM TYPES? 

• Much like AdHoc values in previous versions, Item Types in ORD are tags of meta information attached 

to a MicroStation element. 

• For the Automated Quantities workflow, we will use the Item Types to apply pay item quantity 

information. 

ARE THERE LIMITATIONS TO HOW ITEM TYPES MAY BE APPLIED? 

• For now, Features will only support one Item Type per Feature. 

• Item Types applied with Features do not currently read Alignment for Station and Location information. 

• Asset Manager may be used to apply additional item types to a MicroStation Element and can read 2D 

Station and Location. 
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ASSET MANAGER 

Asset Manager is an application being developed by Bentley that provides additional tools for organizing and 

applying Item Type information. 

• Allows alignment values (station/offset) to be attached to item type data 

• Allows multiple item types to be applied to a single MicroStation element 

• Uses Excel files for database organization and management 

• Provides a method for project-specific item type data to be applied and saved 

• Technology preview (still in development) 

REPORTS AND SUMMARY OF QUANTITIES 

Traditional plan sets (11x17) will include the Summary of Quantities tables as plan sheets. 

• Use Linked Data Manager to attach table 

• Tables completed manually or may be semi-automated by copying data from MicroStation reports 

Next-gen plans with large format sheets and reduced plan sets will provide the Summary of Quantities in a 

separate pdf report. 

• MicroStation reports will generate raw quantity reports 

• FDOT tool (in development) will combine and format raw reports into a single bookmarked pdf to be 

included with the project delivery 

Exercise 8.1 Explore Item Types 

 From the FDOT Connect desktop folder, double-click the ORD FDOT-Roadway icon to launch 

Open Roads Designer with the FDOT Connect workspace.  

 Next, select the FDOT WorkSpace and the 22049555201_CE  WorkSet. 

 

 Choose the Browse button, navigate to the Roadway folder and choose the MODLRD_AQT-

NewCorridor.dgn. 

 Zoom in to the end of the corridor in the 3D view, select an element of 3D mesh, and review the Item Type 

properties. (Note that the field for "Type" should be a pull-down option, but it is not working.) 

 

 

Note To correct this, we’ll need to take a closer look at the Item Types library. 
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 In the top left corner select the Workflow pull-down and change it to the Drawing Workflow. Then select the 

Attach ribbon tab and click the flyout button in the bottom right of the Item Types tool group. 

 

 In the Item Types dialog, hover over the PayItemQuantities category and note that the local resource does 

not match the dgn library. 

 

 Select the PayItemQuantities category and note the tools that activate. Choose the tool to Update From 

Library and click OK. 

 

 Close the Item Types dialog and return to the 3D view.  Review the Item Types properties of a 3D mesh and 

note that now clicking in the field by "Type" will activate a pull-down of options within the Item Type for 

that element. 

 When an option is selected, the other data is populated with the corresponding pay item information. Design 

Notes may be entered in this field and will be attached to the element. 

Note You can use level display and selection sets to select and set groups with the same Item Types. 
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Exercise 8.2 Explore Asset Manager 

 Select the OpenRoads Modeling Workflow, and the Home ribbon tab, then find the Asset Manager tool. 

 

 In the Asset Manager dialog, we’ll need to attach a Definitions File. 

C:\FDOTConnect\Organization-Civil\FDOT\Asset Manager\FDOTLocations.xml 

 

 In the dialog box, set the following information: 

a. Check Location 

b. Set Elements to Selection Set 

c. Select Alignment* 

d. Set Assignment Mode to Add 

e. Create a selection set of elements, then click Apply Assets 

* Asset Manager cannot currently locate the alignment in the 3D view. For demonstration purposes, we can 

attach the 2D alignment to the 3D view, then select it. For now, the location values will not show. This is expected 

to be corrected in future ORD releases, or an alternative method of identifying location data will be developed. 

 

 Note that there is now a new Item Type for Location in the properties of the elements that were in the selection 

set. 
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Exercise 8.3 Updating an Existing Design 

Projects that already in the design phase will need to be updated to apply features with item types. 

Note Bentley has indicated future provisions for an option to update Features from dgnlib that may make the 
update a simple process. 

For this exercise, we will use a file that has already had the features updated and review the process for 

applying the correct quantity information. 

 Select File > Open and Browse to the Roadway folder and open the file MODLRD_AQT-

ExistingUpdated.dgn 

 Verify that the local Item Type resource is up to date with the dgn library. 

(Drawing Workflow > Attach Tab > Item Types) 

 Minimize view 1 (2D) and expand view 2 (3D) 

 Turn off all reference displays  

 In the Explorer window, expand the OpenRoads Standards group, then expand Standards > MODLRD_AQT-

ExistingUpdated.dgn (default) > Feature Definitions > Mesh > XS. 

 

 Uncheck the box for XS to uncheck all the mesh groups. 

 Turn on (check) each of the mesh groups, one at a time, then create a selection set of the items in that group. 

 In the properties display, the item type for each should appear. 

 In the Type field, click the pull down and select the correct type for the element selected.  

Note Features have only been updated on the SR61 corridor. 

* Traffic separator in the corridor displays as one element. This will need to be addressed in the future to 

show appropriate start and end stations for the two separate pieces. 
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Exercise 8.4 Explore Reports 

 Continuing in the same file, in the Drawing Workflow select the Analyze ribbon tab, then select the Reports 

tool. 

 

 Select any of the formatted reports and preview the results. 

 

 Results may be exported to an Excel spreadsheet and saved in the project Calculations folder. 

 

 Raw reports may then be used to copy data to an LDM template, or further processed into a bookmarked pdf 

report through a new FDOT tool (in development). 
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Exercise 8.5 Explore LDM in OpenRoads 

 On the OpenRoads Modeling Workflow > FDOT tab, select the Create Files tool. 

 

 

 Sort by the Base Filename by clicking on the column header. 

 Select the SUMQRD file. 

 Verify the output filename. 

 When the county is set, the coordinate system should update. 

Note The action will create a sheet model in the new file. 

 When all settings are correct, click Create – Open File. 

 If prompted, select use active workspace. 
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 On the primary ribbon tab, open the Models dialog. 

 

 

 The SUMQUANTITIESSHEETS model may be copied as many times as necessary. 

 Each Summary Sheet will need its own model.  Name models based on the name of the Summary table to be 

included on the sheet. 

 Locate and open Linked Data Manager. 

 

 Select Create New Link. 

 

 A partially filled template has been included in the dataset.  Choose the Select existing file button and 

navigate to the project Calculations folder and attach the 

Summary_of_Curb_and_Traffic_Separators_Partial.xlsx 

 Set the Worksheet to Box1. 
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 Check the remaining settings, click OK and place the table on the sheet border. 
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9 OTHER ORD TOOLS 

(Analyze Points, Civil AccuDraw, Aquaplaning, Sight Visibility, Reports, Labels) 

ANALYZE POINTS 

HEADING 3 

Exercise 9.1 Civil Accudraw 

HEADING 3 

Exercise 9.2 Aquaplanning 

HEADING 3 

Exercise 9.3 Sight Visibility 

HEADING 3 

Exercise 9.4 Reports 

HEADING 3 

Exercise 9.5 Labels 

HEADING 3 

EXERCISE OVERVIEW 

9.1  …. 

9.2  …. 

 

Exercise 9.6  

1.  

Exercise 9.7  
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10 EXPORT TO LumenRT 

HEADING 2 

 

HEADING 3 

 

HEADING4 

 

EXERCISE OVERVIEW 

10.1  …. 

10.2  …. 

 

Exercise 10.1  

1.  
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11 VIRTUAL REALITY DESIGN 
REVIEW 

HEADING 2 

 

HEADING 3 

 

HEADING4 

 

EXERCISE OVERVIEW 

12.1  …. 

12.2  …. 

12.3  …. 

12.4  …. 

 

Exercise 11.1  

1.  
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